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1
Overview
Dell SupportAssist for OpenManage Essentials is a service capability that collects information about your 
Dell system hardware and software, and automatically creates support cases when issues arise. This helps 
Dell to provide you an enhanced, personalized, and efficient support experience. Dell uses this data to 
help solve common problems, and to design and market the products and services features you use 
most.

SupportAssist integrates with Dell OpenManage Essentials to provide support capabilities for the 
following Dell enterprise server, storage, and networking solutions, using the existing environment data:

• Dell PowerEdge 9th generation (9G) to 13th generation (13G) servers

NOTE: SupportAssist also supports Integrated Dell Remote Access Controller 7 (iDRAC7) and 
iDRAC8 available on PowerEdge 12G and 13G servers respectively.

• Dell PowerVault NX storage servers

• Dell PowerVault MD storage arrays

• Dell EqualLogic SAN devices

• Dell Networking switches (previously Force10 and PowerConnect)

• Dell PowerEdge M1000e Blade Enclosure

• Dell PowerEdge VRTX

NOTE: For a complete list of supported operating systems and device models, see the Dell 
SupportAssist for OpenManage Essentials Version 2.0 Support Matrix at Dell.com/
ServiceabilityTools.

NOTE: SupportAssist does not support Dell PowerEdge C-series servers, Dell PowerEdge M I/O 
Aggregator, Dell Compellent devices, Dell PowerVault NAS, Dell EqualLogic FluidFS NAS, 
PowerVault MD Series FluidFS NAS, Compellent FluidFS NAS, Dell DR4000, Dell PowerVault 
RD1000, and Brocade switches.

NOTE: SupportAssist provides limited support for PowerConnect stacked configurations.

Equipping your server running OpenManage Essentials with SupportAssist is voluntary, and results in 
improved support, products, and services designed to meet your needs.

NOTE: SupportAssist supports up to 2000 devices.

Key features

The key features of SupportAssist include:

• Monitoring — Monitors your hardware and accelerates identification of issues with e-mail alerts from 
Dell at the time of hardware failure.

• Automatic support case creation — When a critical alert is received from your hardware by 
OpenManage Essentials, the alert information is sent to Dell and a service request is automatically 
created. A Dell technical support agent contacts you about the alert and helps you resolve the issue.
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NOTE: Support cases opened prior to SupportAssist installation and support cases opened by 
contacting Dell technical support, do not appear in the SupportAssist.

• Automated log and configuration collection — Information required for troubleshooting the issue is 
automatically collected and sent to Dell.

• Proactive parts dispatch — Based on examination of the troubleshooting data, if the Dell technical 
support agent determines that a part needs to be replaced in your environment, a replacement part is 
dispatched to you with your consent.

NOTE: SupportAssist also enables reporting for devices with a Dell ProSupport Plus service contract. 
ProSupport Plus reporting provides insight into the as-maintained environment configuration with 
proactive firmware recommendations and other reports.

Features supported with Dell service contracts

The features supported in your environment may vary based on your Dell service contract.

The following table provides a comparison of the features available with the Dell Basic Hardware, Dell 
ProSupport, and Dell ProSupport Plus service contracts.

Feature Basic Hardware ProSupport ProSupport Plus

Monitoring

Automated log and configuration 
collection

Automatic support case creation

Proactive parts dispatch

ProSupport Plus reports

Case data handling

For increased performance, SupportAssist case data is cached prior to display in the dashboard, and is not 
displayed in real time. When started, SupportAssist queries Dell once every 15 minutes for all cases to 
determine if it needs to update the case status.

Event handling

SupportAssist intelligently handles event storm conditions, allowing up to nine separate alerts from your 
OpenManage Essentials-managed environment in a 60-minute time span. However, if it receives 10 or 
more separate alerts it automatically enters maintenance mode. For information on maintenance mode, 
see Preferences and Setting SuppotAssist to maintenance mode.

Maintenance mode suspends any further processing of alerts, enabling you to make infrastructure 
changes without generating unnecessary alerts. After 30 minutes in maintenance mode, SupportAssist 
automatically exits maintenance mode and resumes normal alert processing.
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Data collected by SupportAssist
NOTE: By default, SupportAssist collects data from all supported devices in an environment, 
irrespective of the service contract type of the devices, and uploads the data to Dell. The collection 
of data is staggered, and the data is collected from 5 to 10 devices at a time. For information about 
the default frequency of data collection, see Default system log collection schedule.

SupportAssist continually monitors the configuration data and usage information of OpenManage 
Essentials-managed Dell hardware and software. While Dell does not anticipate accessing or collecting 
personal information, such as your personal files, web-browsing history, or cookies, in connection with 
this program, any personal data inadvertently collected or viewed will be treated in accordance with the 
Dell Privacy Policy available for review at Dell.com/privacy.

The information encrypted in the data log sent to Dell includes the following categories of data:

• Hardware and software inventory — Installed devices, processor(s), memory, network devices, usage, 
and Service Tag.

• Software configuration for servers — Operating system and installed applications.

• Network identity information – Computer name, domain name, and IP address.

• Event data — Windows event logs, core dump, and debug logs.

For more information about the collected troubleshooting information, see Accessing and viewing the 
system log collection.

NOTE: If the security policy of the company restricts sending some of the collected data outside of 
the company network, you can configure SupportAssist to filter the collected data before sending it 
to Dell. For more information, see Filtering the system log collection.

NOTE: For more information about the data collected by SupportAssist and how the collected data 
is used by Dell, see the Dell SupportAssist: Security Considerations technical document at Dell.com/
SupportAssistGroup.

What is new in this release

• New device support — Support for Dell PowerEdge 13th generation (13G) servers.

• Registration and setup — New workflow for the installation, registration, and setup of SupportAssist.

• Device status notification — Ability to verify and notify the connectivity status, configured credentials, 
and collection capability of each device.

• Network connectivity — Ability to verify and notify network connectivity to dependent sources such as 
proxy server, firewall, SupportAssist server, Dell File Transfer Protocol (FTP) server, and so on.

• Device grouping — Ability to create a logical grouping of devices that enables easier management of 
the devices.

• Local e-mail server configuration — Ability to configure and utilize the local Simple Mail Transfer 
Protocol (SMTP) e-mail server, if available, for sending SupportAssist e-mail notifications.

• Rebranding of devices — Support for Dell Networking switches (previously Dell Force10 and Dell 
PowerConnect switches).

• Contact information — Ability to select the preferred contact method and time, and also provide the 
parts dispatch address.
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• Uninstallation feedback — Availability of an option to provide feedback to Dell during the 
uninstallation of SupportAssist.
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2
Installing, upgrading, and uninstalling 
SupportAssist
The following sections provide information about installing, upgrading, and uninstalling SupportAssist.

Prerequisites

The following are the prerequisites:

• Dell PowerEdge servers running Dell OpenManage Essentials version 2.0

• Familiarity with OpenManage Essentials installation, configuration, and operation

For more information about installing, configuring, and using OpenManage Essentials, see the 
appropriate Dell OpenManage Essentials User’s Guide and Dell OpenManage Essentials Release Notes at 
Dell.com/OpenManageManuals.

Minimum requirements

This section provides the minimum requirements for SupportAssist to provide proactive support for Dell 
devices.

NOTE: For information about SNMP configuration, firewall settings, web services, supported ports 
and protocols specific to your environment, see the Dell SupportAssist Version 2.0 Quick Start 
Guide and the Dell OpenManage Essentials User’s Guide at Dell.com/OpenManageManuals.

Related Links

Software requirements

Hardware requirements

Network requirements

Software requirements

The following are the minimum required software configurations:

• Dell OpenManage Essentials version 2.0.

• Optional: Dell OpenManage Server Administrator (OMSA) installed and operational on all managed 
PowerEdge servers.

NOTE: OMSA is required for monitoring Dell PowerEdge servers only if you discover the servers 
using the operating system IP address. OMSA is not required to monitor Dell PowerEdge 12th 
generation (12G) or later servers if you discover the server using the iDRAC IP address.

• SNMP agent must be enabled on all managed PowerEdge servers, EqualLogic, PowerVault, iDRAC, 
CMC, Networking (previously Force10 and PowerConnect), and PowerEdge VRTX devices for 
OpenManage Essentials discovery.
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• All managed PowerEdge, EqualLogic, PowerVault, iDRAC, CMC, Networking (previously Force10 and 
PowerConnect), and PowerEdge VRTX devices must be configured to send SNMP traps to the 
OpenManage Essentials server.

• All managed PowerEdge, EqualLogic, PowerVault, iDRAC, CMC, Networking (previously Force10 and 
PowerConnect), and PowerEdge VRTX devices must be discovered, categorized, and inventoried by 
the OpenManage Essentials server.

NOTE: For monitoring EqualLogic storage arrays in SupportAssist, you must discover the 
EqualLogic storage arrays in OpenManage Essentials using the Group Management IP or 
Storage Group IP.

• PowerVault Modular Disk Storage Manager (MDSM) must be installed on the OpenManage Essentials 
server to support PowerVault MD Series arrays.

• A trust relationship must exist between the domains of the management server and the managed 
nodes.

• Microsoft .Net Framework 4.5

• Microsoft ASP.Net

• IIS 7.x or 8.x

• Web browser – Internet Explorer 9, 10, or 11; Mozilla Firefox 22 or 23; supported only on Windows-
based operating systems.

Hardware requirements

The following are the minimum recommended hardware configurations:

Hardware Small deployments Medium deployments Large deployments

Number of managed 
systems

Up to 100 devices Up to 500 500 to 2000

Processor 4 cores (1.8 GHz 
minimum)

6 cores (1.8 GHz 
minimum)

10 cores (1.8 GHz 
minimum)

Memory (RAM) 6 GB 8 GB 10 GB

Hard drive

NOTE: If 
SupportAssist is 
configured to 
collect the system 
logs at regular 
intervals, additional 
hard-drive space is 
required. The hard-
drive space 
required can be 
determined as 10 
MB x number of 
managed devices.

6 GB 6 GB 10 GB
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Network requirements

The following are the minimum network requirements:

• Internet connection – standard Gbe network.

• The management server on which SupportAssist is installed must be able to communicate with the 
SupportAssist server hosted by Dell over the HTTPS protocol.

• The management server on which the SupportAssist is installed must be able to connect to the 
following destinations:

– https://api.dell.com/support/case/v2/WebCase — end point for the SupportAssist server.

– https://ddldropbox.us.dell.com/upload.ashx/ — the file upload server where the diagnostic test 
results are uploaded.

– https://ftp.dell.com/ — for new SupportAssist release information.

NOTE: To verify if the destinations are reachable, follow the instructions in Ensuring 
successful communication between the SupportAssist application and the SupportAssist 
server.

The following table lists the ports that must be open on the management server and the managed nodes

Device Port Usage

Management 
server

2607 Console launch

NOTE: The default port for console launch is 2607. If you selected a 
custom port for console launch, make sure that the port you selected 
is open.

162 Event reception through SNMP

443 Secure Socket Layer (SSL) communication and SupportAssist update 
information

9399 Hosting the Windows Communication Foundation (WCF) service

25 SMTP communication

Managed 
nodes

161 Sending and receiving SNMP requests

1311 Dell OpenManage Server Administrator (OMSA) communication

NOTE: For information about the other dependent ports, see the “Supported Protocols and Ports” 
section in the Dell OpenManage Essentials User’s Guide at Dell.com/OpenManageManuals.

Installing SupportAssist

You can install SupportAssist by downloading one of the following installation packages:

• Dell SupportAssist version 2.0 available at Dell.com/SupportAssistGroup.

• Dell OpenManage Essentials version 2.0 available at DellTechCenter.com/OME.

By installing SupportAssist, you agree to the Dell End User License Agreement — Type A, available for 
review at dell.com/softwarelicenseagreement; and the Dell Privacy Policy available for review at 

13



Dell.com/privacy. The use of SupportAssist is also subject to the terms of the Service Agreement and 
Terms and Conditions of Sale.

Installing SupportAssist using the SupportAssist installation package

To install:

NOTE: Before you begin, make sure that:

• The system is able to connect to the Internet.

• You have Administrator privileges on the system.

• Port 443 is open on the firewall to access https://ftp.dell.com, https://ddldropbox.us.dell.com/
upload.ashx/, and https://api.dell.com/support/case/v2/WebCase.

1. On the management server, right-click the SupportAssist installer package, and select Run as 
administrator.

NOTE: Microsoft User Access Control (UAC) requires that the installation is performed with 
elevated privileges that are obtained only through the Run as administrator option. If you are 
logged on to the management server as an Administrator, double-click the installer package to 
install SupportAssist. However, ensure that you click Run on the Open File - Security Warning 
dialog box to proceed.

The Preparing to Install window is displayed briefly, and then the Welcome to Dell SupportAssist 
window is displayed.

2. Read the terms, and click I Agree.

The License Agreement window is displayed.

3. Read the software license agreement, select I accept the terms in the license agreement, and then 
click Next.

The Ready to Install the Program window is displayed.

4. Click Install.

The Installing SupportAssist window is displayed briefly, and then the Installation Wizard 
Completed window is displayed.

5. Click Finish.

The SupportAssist Setup Wizard is displayed in a new browser window.

NOTE: You must complete all applicable steps in the SupportAssist Setup Wizard before you 
can use SupportAssist.

Installing SupportAssist using the OpenManage Essentials installation 
package

To install:

NOTE: Before you begin, make sure that:

• The system is able to connect to the Internet.

• You have Administrator rights on the system.

• Port 443 is open on the firewall to access https://ftp.dell.com, https://ddldropbox.us.dell.com/
upload.ashx/, and https://api.dell.com/support/case/v2/WebCase.
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NOTE: If the installation of SupportAssist is unsuccessful, you can retry the installation at a later 
time. To retry the installation, right-click the DellSupportAssistSetup.exe file available at C:\Program 
Files\Dell\SysMgt\Essentials\SupportAssistSetup or the OpenManage Essentials custom installation 
folder, and select Run as administrator.

1. Extract the OpenManage Essentials installation package to a folder on the system.

2. In the folder where you extracted the installation package, double-click the Autorun.exe file.

The Dell OpenManage Install window is displayed.

3. If OpenManage Essentials version 2.0 is not installed on the system, make sure that Dell 
OpenManage Essentials is selected.

4. Select Dell SupportAssist, and then click Install.

If you selected Dell OpenManage Essentials and Dell SupportAssist, installation of OpenManage 
Essentials is completed and then SupportAssist is installed. The system prerequisites for installing 
SupportAssist are verified. If the system prerequisites are met, the Welcome to Dell SupportAssist 
Installer window is displayed.

5. Click Next.

The License Agreement window is displayed.

6. Read the terms in the communication requirements and click I Agree.

NOTE: SupportAssist installation requires that you allow Dell to save certain Personally 
Identifiable Information (PII) such as your contact information, administrator credentials of the 
devices to be monitored, and so on. SupportAssist installation cannot proceed unless you allow 
Dell to save your PII.

7. Read the software license agreement, click I Agree, and then click Next.

If the system connects to the Internet through a proxy server, the Proxy Settings window is 
displayed. Else, the Installing SupportAssist window is displayed briefly, and then the Installation 
Completed window is displayed.

8. If the Proxy Settings window is displayed, provide the following:

a. In the Server Address field, type the proxy server address or name.

b. In the Port field, type the proxy port number.

NOTE: If the proxy server credentials are not provided, SupportAssist connects to the proxy 
server as an anonymous user.

c. If the proxy server requires authentication, select Proxy requires authentication, and then 
provide the following information in the corresponding fields:

• Username — The user name must contain one or more printable characters, and must not 
exceed 104 characters.

• Password — The password must contain one or more printable characters, and must not 
exceed 127 characters.

• Confirm Password — Re-enter the password. The password must match with the one 
provided in the Password field.

d. Click Install.

The proxy settings are validated. If the validation is unsuccessful, verify the proxy settings and try 
again or contact your network administrator for assistance.

e. In the Validation Successful dialog box, click OK.

The Installing SupportAssist window is displayed briefly, and then the Installation Completed 
window is displayed.

9. Click Finish.
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When you start SupportAssist, the SupportAssist Setup Wizard is displayed. You must complete all steps 
in the SupportAssist Setup Wizard before you can use SupportAssist.

Setting up SupportAssist

The SupportAssist Setup Wizard guides you through configuring proxy server settings (if applicable), 
completing the registration, and other steps. The wizard opens in a new web browser window when you 
click Finish on the SupportAssist Installation Completed window. The wizard is also displayed when you 
start SupportAssist, if you have not completed the applicable steps in the wizard earlier.

NOTE: You must complete all applicable steps in the SupportAssist Setup Wizard before you can 
use SupportAssist.

To set up SupportAssist:

1. On the Welcome to SupportAssist page of the SupportAssist Setup Wizard, click Next.

If your network connects to the internet through a proxy server, the Proxy Settings page is displayed. 
Else, the Registration page is displayed.

2. If the Proxy Settings page is displayed:

a. In the Address field, type the proxy server IP address or host name.

b. In the Port field, type the proxy server port number.

c. If the connection to the proxy server requires a user name and password, select Requires 
authentication, and type the user name and password in the appropriate fields.

d. Click Next.

SupportAssist verifies the connection to the proxy server using the provided proxy server details. If 
the connection is successful, the Registration page is displayed. Else, an error message is displayed. 
If the proxy server connection problem persists, you may contact your network administrator for 
assistance.

3. If the Registration page is displayed, provide the following information:

• Company Name — The company name must contain one or more printable characters, and must 
not exceed 256 characters.

• Country/Territory — Select your country or territory.

• First Name — The first name can contain letters, quotation marks [ ’ ], periods [ . ], spaces, and 
must not exceed 50 characters.

• Last Name — The last name can contain letters, quotation marks [ ’ ], periods [ . ], spaces, and 
must not exceed 50 characters.

• Phone Number — It must contain a minimum of 10 characters and must not exceed 50 
characters.

• Alternate Phone Number — Optional, with the same requirements as the Phone Number.

• Email Address — Type the e-mail address in the name@company.com format. It must contain a 
minimum of 5 characters and not exceed 50 characters.

• Preferred Email Language — Select the desired language for SupportAssist e-mail notifications.

NOTE: After setting up SupportAssist, you can update the primary contact information and also 
provide a secondary contact information. If the primary contact is unavailable, Dell can contact 
your company through the secondary contact. If both the primary and secondary contacts are 
configured with valid e-mail addresses, both receive SupportAssist e-mails. You can also select 
a preferred contact method and time, and a parts dispatch address while updating the contact 
information. For information about updating the contact information, see Viewing and updating 
the contact information.

4. Click Next.
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SupportAssist connects to Dell and completes the registration. If the registration is successful, the 
System Credentials page is displayed. Else, an error message is displayed. If the registration problem 
persists, you may contact your network administrator for assistance.

5. On the System Credentials page, type the user name and password of the user account required to 
connect to OpenManage Essentials. SupportAssist uses the System Credentials to connect to 
OpenManage Essentials and retrieves device and alert information.

NOTE: The user account must be a member of the OpenManage Essentials Administrators, 
Power Users, or Site Administrators group.

NOTE: If you change the credentials of the user account because of the security policy 
requirements of your company or for other reasons, make sure that you also update the 
System Credentials in SupportAssist. It is recommended that you create a service account with 
credentials that do not expire, and provide the service account credentials.

6. Click Next.

The Summary page is displayed.

7. Click Finish.

The SupportAssist Cases page is displayed. The supported devices that you have discovered in 
OpenManage Essentials are displayed in the Devices page.

While you complete the steps in the setup wizard, additional SupportAssist components are 
downloaded and installed in the background. The SupportAssist components generate the system 
logs from supported Dell devices, then compress and upload the system logs for use by Dell 
technical support to diagnose issues. For information about the generated system logs, see 
Accessing and viewing the system log collection.

NOTE: If the SupportAssist components are already installed on the system, the components 
are automatically migrated to a version compatible with SupportAssist.

To enable SupportAssist to monitor devices in your environment, follow the instructions in Getting 
started with SupportAssist.

Upgrading SupportAssist
NOTE: Upgrade to SupportAssist version 2.0 is supported if OpenManage Essentials version 2.0 is 
installed on the system. For information on installing or upgrading to OpenManage Essentials 
version 2.0, see the OpenManage Essentials Version 2.0 User’s Guide at dell.com/
OpenManageManuals.

You can upgrade SupportAssist version 1.2, 1.2.1, 1.3, or 1.3.1 to version 2.0. To upgrade SupportAssist, 
download one of the following:

• SupportAssist version 2.0 installation package available at Dell.com/SupportAssistGroup.

• Dell OpenManage Essentials version 2.0 installation package available at DellTechCenter.com/OME.

NOTE: Before you upgrade SupportAssist, ensure that SupportAssist is not open in any web browser 
window.

Upgrading SupportAssist using the SupportAssist installation package

To upgrade:

1. On the Dell OpenManage Essentials management server, right-click the SupportAssist installer 
package, and select Run as administrator.
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NOTE: UAC requires that the installation is performed with elevated privileges that are obtained 
only through the Run as administrator option. If you are logged on to the OpenManage 
Essentials server as an administrator, double-click the installer package to install SupportAssist. 
However, ensure that you click Run on the Open File - Security Warning dialog box to 
proceed.

The Dell SupportAssist - InstallShield Wizard window is displayed.

2. At the This setup will perform an upgrade of 'Dell SupportAssist'. Do you want to continue? 
prompt, click Yes.

The Preparing to Install window is briefly displayed, and then the Resuming the Install Wizard for 
SupportAssist window is displayed.

3. Click Next.

The Install Wizard Completed window is displayed.

4. Click Finish.

The SupportAssist Setup Wizard is displayed in a new browser window.

NOTE: You must complete all applicable steps in the SupportAssist Setup Wizard before you 
can use SupportAssist.

Upgrading SupportAssist using the OpenManage Essentials installer package

To upgrade:

1. Double-click the OpenManage Essentials executable file.

The Dell OpenManage Install window is displayed.

NOTE: If SupportAssist is already installed on the system, by default, the Dell SupportAssist 
option is selected and grayed out.

2. Click Install.

The Welcome to Dell SupportAssist Installer window is displayed.

3. If the Proxy Settings window is displayed, provide the following:

a. In the Server Address field, type the proxy server address or name.

b. In the Port field, type the proxy port number.

NOTE: If the proxy server credentials are not provided, SupportAssist connects to the proxy 
server as an anonymous user.

c. If the proxy server requires authentication, select Proxy requires authentication, and then 
provide the following information in the corresponding fields:

• Username — The user name must contain one or more printable characters, and must not 
exceed 104 characters.

• Password — The password must contain one or more printable characters, and must not 
exceed 127 characters.

• Confirm Password — Reenter the password. The password must match with the one provided 
in the Password field.

d. Click Next.

The proxy settings are validated. If the validation is unsuccessful, verify the proxy settings and try 
again or contact your network administrator for assistance.

e. On the Validation Successful dialog box, click OK.

The Installation Completed window is displayed.
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4. Click Finish.

The SupportAssist Setup Wizard is displayed in a new browser window.

NOTE: If you also upgraded OpenManage Essentials, you must run discovery and inventory of 
all existing discovery ranges in OpenManage Essentials.

NOTE: You must complete all applicable steps in the SupportAssist Setup Wizard before you 
can use SupportAssist.

Setting up SupportAssist after an upgrade

The SupportAssist Setup Wizard guides you through updating the registration details and connecting to 
OpenManage Essentials. The wizard opens in a new web browser window when you click Finish on the 
SupportAssist Installation Completed window. The wizard is also displayed when you start SupportAssist, 
if you have not completed the applicable steps in the wizard earlier.

NOTE: You must complete all applicable steps in the SupportAssist Setup Wizard before you can 
use SupportAssist.

To set up SupportAssist:

1. On the Welcome to SupportAssist page of the SupportAssist Setup Wizard, click Next.

The Registration page is displayed with your existing registration details.

2. On the Registration page, update the details based on your preference, and click Next.

3. Click Next.

SupportAssist connects to Dell and updates the registration details. If the registration is successful, 
the System Credentials page is displayed. Else, an error message is displayed. If the registration 
problem persists, you may contact your network administrator for assistance.

4. On the System Credentials page, type the user name and password of the user account required to 
connect to OpenManage Essentials. SupportAssist uses the System Credentials to connect to 
OpenManage Essentials and retrieves device and alert information.

NOTE: The user account must be a member of the OpenManage Essentials Administrators, 
Power Users, or Site Administrators group.

NOTE: If you change the credentials of the user account because of your company’s security 
policy requirements or for other reasons, make sure that you also update the System 
Credentials in SupportAssist. It is recommended that you create a service account with 
credentials that do not expire, and provide the service account credentials.

5. Click Next.

The Summary page is displayed.

6. Click Finish.

The SupportAssist Cases page is displayed in a new browser window. The supported devices that you 
have discovered in OpenManage Essentials are displayed in the Devices page.

Uninstalling SupportAssist
To uninstall:

NOTE: Uninstalling SupportAssist also uninstalls the associated SupportAssist components. If the 
components are running during the uninstallation, a message is displayed.

1. On the OpenManage Essentials management server, click Start → Control Panel → Programs and 
Features.
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The Programs and Features window is displayed.

2. Select Dell SupportAssist, and then click Change.

The Welcome to the Install Wizard for SupportAssist window is displayed.

3. Click Next.

The Program Maintenance window is displayed.

4. Select Remove, and click Next.

The SupportAssist feedback window is displayed.

5. Select an appropriate reason from the Select an option drop-down list, provide your comments, and 
click Next.

The Remove the Program window is displayed.

6. Click Remove.

The Uninstalling SupportAssist window is displayed.

7. Click Finish.

SupportAssist and the associated components are now uninstalled from the server running 
OpenManage Essentials.

20



3
Using Dell SupportAssist
The following sections provide information about configuring and using SupportAssist.

Starting SupportAssist
You can start SupportAssist from either the management server or a remote system.

• To start SupportAssist from the management server:

– Double-click the Dell SupportAssist desktop icon.

– If the server is running Windows Server 2008 — Click Start→ All Programs→ Dell→ 
SupportAssist→ SupportAssist.

– If the server is running Windows Server 2012 — Move the mouse pointer to the bottom-left corner, 
and then click the Start icon. On the Start screen, click the SupportAssist tile.

• To start SupportAssist from a remote system, open a web browser and type the address in the 
following format: https://<IP address or host name of management server>:Port 
Number/DIS. For example, https://10.25.35.1:2607/DIS.

SupportAssist opens in a web browser window and displays the Cases page.

NOTE: The recommended screen resolution for optimal viewing of the SupportAssist dashboard is 
1280 x 1024 or higher.

Getting started with SupportAssist
NOTE: If you upgraded to OpenManage Essentials version 2.0, you must run discovery and 
inventory of all existing discovery ranges in OpenManage Essentials.

After installing SupportAssist and completing the steps in the setup wizard, the supported devices 
discovered in OpenManage Essentials are displayed in the Device Inventory page.

To enable SupportAssist to monitor the supported devices, automatically generate support cases if there 
is a problem with any devices, and upload the system log collection to Dell, you must:

1. Establish monitoring and system log collection — Configure the Default Device Type Credentials in 
the System Logs page for each supported device type. See Configuring the default device type 
credentials.

2. Configure the local SMTP e-mail server settings — If a local SMTP e-mail server is available in your 
environment, it is recommended that you configure the local SMTP server settings in SupportAssist. 
See Configuring the local SMTP e-mail server settings.

3. Test the network connectivity status — Verify SupportAssist connectivity status to make sure that 
SupportAssist is able to connect to all dependent network resources successfully. See Performing the 
connectivity test.

4. Verify the status of devices — Make sure that the devices in the Device Inventory page do not display 
an Error status. See Verification of device status.
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Configuring the default device type credentials

SupportAssist runs the appropriate collection components and gathers the system logs from 
OpenManage Essentials-managed Dell server, storage, and switch devices. To run the collection 
components on your supported devices, you must configure SupportAssist with the Administrator 
credentials for each managed device type. The Default Device Type Credentials section in the System 
Logs page enables you to configure SupportAssist with the Administrator credentials for each supported 
device type and credential type.

NOTE: If you change the Administrator credentials because of the security policy requirements of 
your company or for other reasons, you must ensure that the Default Device Type Credentials are 
also updated in SupportAssist. Alternatively, you can create a service account that never expires, and 
provide the service account credentials in SupportAssist.

For example, if the managed PowerEdge servers are part of a domain, you can create a service 
account on the domain controller, and add the service account to the Local Administrators group of 
the managed server. Then, provide the service account credentials in the Default Device Type 
Credentials page in SupportAssist. For more information, see the Managing Windows Device 
Credentials in SupportAssist Using Service Account technical white paper at Dell.com/
SupportAssistGroup.

NOTE: SupportAssist does not require the credentials for collecting system logs from Dell 
PowerVault MD series storage arrays.

To configure the default device type credentials:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Under Edit Device Credentials, select the Device Type from the list. You can select from:

• Server

• Storage

• Switch

3. Select the Credential Type from the list. The options listed vary based on the Device Type you 
selected.

The options for Server are:

• Windows

• Linux

• ESX/ESXi

• iDRAC

• CMC

The options for Storage are:

• EqualLogic

• MD Series

The option for Switch is Dell Networking.

4. Type the credentials in the corresponding fields:
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NOTE: For Dell Networking switches (previously Force10 and PowerConnect), the Username, 
Password, and Enable Password fields are optional. However, information must be provided for 
these fields if the Networking switch is configured with these details.

• Username — The user name must contain one or more printable characters, and not exceed 104 
characters.

NOTE: Windows user names must be of the form [Domain\Username]. You can also use a 
period [ . ] to indicate the local domain. This rule does not apply to Linux or ESX/ESXi 
credentials.

NOTE: For Networking switches the domain name need not be specified.

Examples of Windows user names: .\Administrator; MyDomain\MyUsername

Example of Linux, ESX/ESXi user name: Username

• Password — The user password must contain one or more printable characters, and not exceed 
127 characters.

• Enable Password — For Ethernet switches only. The enable password must contain one or more 
printable characters, and not exceed 127 characters.

• Community String — For EqualLogic storage arrays only. The community string of the storage 
device.

NOTE: The Default Device Type Credentials are encrypted and saved locally.

5. Repeat step 2 to step 4 until you have configured the default credentials for all device types in your 
environment.

6. Click Save Changes.

If the credentials for a device differs from the Default Device Type Credentials you provided, you can edit 
the device credentials for that particular device. For more information about providing the credentials for 
a specific device, see Editing device credentials.
Related Links

Device credentials used by SupportAssist

System Logs

Editing device credentials

Configuring the local SMTP e-mail server settings
If you have a Simple Mail Transfer Protocol (SMTP) server in your environment, you can configure 
SupportAssist to send you device status and connectivity status e-mail notifications through the local 
SMTP server.

NOTE: You may not receive certain device status and connectivity status e-mails in the following 
scenarios:

• An SMTP server is available in your environment, but:

– The SMTP server settings are not configured in SupportAssist.

– The SMTP server credentials you have provided in SupportAssist are incorrect.

– The Secure Socket Layer (SSL) certificate of the SMTP server is expired.

– An anti-virus software is blocking the SMTP server port configured in SupportAssist.

• An SMTP server is not available in your environment.

To configure the SMTP server settings:
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NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click SMTP Settings.

The SMTP Settings page is displayed.

3. Provide the following information in the corresponding fields:

• SMTP server name/IP address — The name or the IP address of the SMTP server.

• Port Number— The port number of the SMTP server.

4. If the SMTP server require authentication for sending e-mails, select SMTP server requires 
authentication.

5. Provide the following information in the corresponding fields:

• Username — The user name must contain one or more printable characters, and not exceed 104 
characters.

• Password — The user password must contain one or more printable characters, and not exceed 
127 characters

• Confirm Password — Repeat the user password. The password should match with the one 
provided in the Password field.

6. If your environment supports SSL communication, select Enable SSL.

7. Click Save Changes.

Verification of device status

By default, for each device listed in the Device Inventory page, SupportAssist automatically verifies the 
following:

• Availability of the device on the network

• Connection to the device

• System log collection capability

The result of the device verification is displayed in the Status column in the Device Inventory page.

The device verification is started automatically in the background in the following scenarios:

• After the installation, upgrade, or auto upgrade of SupportAssist

• After you configure the default device type credentials or schedule periodic collection of system logs.

• After you edit the device credentials.

• After you update the device group credentials

If a device is setup correctly for SupportAssist functionality, the status of the device is displayed as 
Device Configured.

If there is an issue with the device setup, an  Error status may be displayed. To view the description of 
the issue and possible resolution steps, click the Error link.
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If the SMTP Server Settings is configured in SupportAssist, a device status e-mail, that includes devices 
that have setup issues is sent at 5 pm (management server time) each day.

NOTE: The device status e-mail is sent only if there are devices with setup issues that were not 
notified earlier.

For more information on the device status, see the status descriptions in Device Inventory.

Connectivity test

The Connectivity Test page enables you to verify and test SupportAssist connectivity status to the 
following dependent resources:

• Internet

• Local SMTP e-mail server

• Dell File Transfer Protocol (FTP) server

• Collection file upload server hosted by Dell

• Dell OpenManage Essentials service

• SupportAssist server hosted by Dell

By default, SupportAssist verifies the connectivity status to the dependent resources every day at 11 pm 
(management server time). If there is a problem with the connectivity to a dependent resource, an e-mail 
notification is sent to your primary and/or secondary SupportAssist contacts.

NOTE: The e-mail notification is only sent if you have configured SupportAssist to use the local 
SMTP e-mail server. See Configuring the local SMTP e-mail server settings.

On the Connectivity Test page, you can view the connectivity test status and also test SupportAssist 
connectivity to the dependent resources. The connectivity test page is refreshed periodically to display 
the connectivity status information.

NOTE: If you test connectivity to the Dell SupportAssist Server, a connectivity status e-mail is sent 
to your primary and secondary contact.

Viewing the connectivity test status

To view the connectivity test status:

Move the mouse pointer over the user name link that is displayed beside the Help link, and then click 
Connectivity Test.

The Connectivity Status column of the Connectivity Test page displays the result of the connectivity 

test. If an  Error status is displayed, you can click the Error link to view the description of the problem 
and the possible resolution steps.

Performing the connectivity test

To test connectivity:

1. Move the mouse pointer over the user name link that is displayed beside the Help link, and then click 
Connectivity Test.
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The Connectivity Test page is displayed.

2. Select the tests that you want to verify.

NOTE: The Test Connectivity button is enabled only if you are logged on as a member of the 
OpenManage Essentials Administrators, Power Users, or Site Administrators group.

3. Click Test Connectivity.

The Connectivity Status column displays the result of the connectivity test. If an  Error status is 
displayed, click the Error link to view the description of the problem and the possible resolution 
steps.

Related Links

Connectivity Test

Editing device credentials
The Default Device Type Credentials that you provided for each Device Type and Credential Type in the 
System Logs page is used to run the collection component on your managed devices and gather the 
system logs. If the credentials for a particular device differ from the Default Device Type Credentials you 
provided, you can edit the credentials for that device.

CAUTION: After you edit the credentials for a specific device, SupportAssist uses the device-
specific credentials you provided to collect the system logs on that device.

NOTE: To ensure that SupportAssist is able to generate the system log collection for all devices, you 
must edit the credentials for each device which has credentials that are not the same as the Default 
Device Type Credentials.

NOTE: SupportAssist does not require the credentials for collecting system logs from Dell 
PowerVault MD series storage arrays.

To edit the credentials for a device:

NOTE: The Edit Device Credentials option is enabled only if you are logged on as a member of the 
OpenManage Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Devices tab.

The Device Inventory page is displayed.

2. Select a device in the Device Inventory table.

The Edit Device Credentials link is enabled.

3. Click Edit Device Credentials.

NOTE: If the device you selected does not require credentials to generate the system log 
collection, a message is displayed on the dashboard.

The Edit Device Credentials dialog box is displayed.

4. Type the Username, Password, Enable Password (if applicable), and Community String (if applicable) 
in the appropriate fields.

5. Click Save Changes.

The Confirmation dialog box is displayed.

CAUTION: If you select the Do not show this reminder again option, SupportAssist does not 
prompt for your confirmation when you attempt to edit the device credentials the next time.

6. Click Yes.
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The dashboard displays the following message: Your device credentials were saved 
successfully.

Related Links

Device credentials used by SupportAssist

Configuring the default device type credentials

Resetting the device-specific credentials to the default device type credentials

Overwriting the device-specific credentials with the default device type credentials

Resetting the device-specific credentials to the default 
device type credentials
If you had edited the credentials for a particular device, and later want to reset the credentials for that 
device to the Default Device Type Credentials, you can do so using the Edit Device Credentials dialog 
box.

CAUTION: Resetting to the Default Device Type Credentials overwrites the device-specific 
credentials with the default credentials. After you reset the credentials, SupportAssist uses the 
Default Device Type Credentials to collect the system logs on that device.

NOTE: You can reset the device-specific credentials to the Default Device Type Credentials for 
only one device at a time using the Edit Device Credentials dialog box. To overwrite the device-
specific credentials for multiple devices belonging to a particular Device Type and Credential Type 
at a time, see Overwriting the device-specific credentials with the default device type credentials.

To reset the device-specific credentials to the default device type credentials:

NOTE: To reset the device-specific credentials to the Default Device Type Credentials, you must be 
logged on as a member of the OpenManage Essentials Administrators, Power Users, or Site 
Administrators group.

1. Click the Devices tab.

The Device Inventory is displayed.

2. Select a device in the Device Inventory table.

The Edit Device Credentials link is enabled.

3. Click Edit Device Credentials.

The Edit Device Credentials dialog box is displayed.

4. Click Reset to Default Device Type Credentials.

NOTE: The Reset to Default Device Type Credentials link is displayed only if you had previously 
configured the selected device with specific credentials.

The Confirmation dialog box is displayed.

CAUTION: If you select the Do not show this reminder again option, SupportAssist does not 
prompt for your confirmation when you attempt to reset the device-specific credentials the 
next time.

5. Click Yes.

Related Links

Editing device credentials
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Overwriting the device-specific credentials with the 
default device type credentials
If you had edited the credentials for several devices, and later want to overwrite the credentials for all 
those devices to the Default Device Type Credentials, you can do so using the System Logs page.

CAUTION: Once you overwrite the device-specific credentials, the Default Device Type 
Credentials overwrites the credentials of devices that you had previously edited through the Edit 
Device Credentials link.

NOTE: You can overwrite the device-specific credentials to the Default Device Type Credentials for 
all devices belonging to a particular Device Type and Credential Type at a time through the System 
Logs page. To reset the device-specific credentials for only a particular device, see Resetting the 
device-specific credentials to the default device type credentials.

To reset the device-specific credentials to the default device type credentials:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Select the device category from the Device Type list.

3. Select the credential category from the Credential Type list.

4. Select Overwrite the device-specific credentials with the Default Device Type Credentials for all 
devices belonging to the current Device Type and Credential Type.

The Confirmation dialog box is displayed.

CAUTION: If you select the Do not show this reminder again option, SupportAssist does not 
prompt for your confirmation when you attempt to overwrite the device-specific credentials 
the next time.

5. Click Yes.

6. Click Save Changes.

Related Links

System Logs

Editing device credentials

Filtering the system log collection
The system logs collected by SupportAssist includes personally identifiable information (PII) such as the 
complete configuration snapshot of storage systems, hosts, and network devices which can contain host 
identification and network configuration data.

In most cases, part or all of this data is required to properly diagnose issues. The security policy of your 
company may restrict sending this data outside of your network. You can prevent sending this data to 
Dell by configuring SupportAssist to filter the system log collection.

The following is the network identity information that you can filter from the system log collection:

• Host name

• IP address
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• Subnet mask

• Default gateway

• MAC address

• DHCP server

• DNS server

• Processes

• Environment variables

• Registry

• Logs

• iSCSI data

NOTE: When the Send network identification information to Dell option is cleared, some of the 
data about your network is not transmitted to Dell. This may impede Dell technical support from 
resolving your issue.

NOTE: If your devices are covered under the Dell ProSupport Plus service contract, when the Send 
network identification information to Dell option is disabled, you will not receive some reporting 
information about your devices.

To filter the system log collection:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Preferences page is displayed.

3. Under System Log Collection Details, clear the Send network identification information to Dell 
option.

NOTE: By default, the Send network identification information to Dell option is selected.

4. Click Save Changes.

Related Links

Preferences

Sending the system logs manually
When a support case is opened or updated, the SupportAssist application, runs the collection 
components on the devices that generated the alerts, and then uploads the system logs to Dell. In certain 
conditions, if required by Dell technical support, you may be required to manually collect the system logs 
and send it to Dell.

To send the system logs manually:

NOTE: The Send System Logs option is enabled only if you are logged on as a member of the 
OpenManage Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Devices tab.

The Device Inventory is displayed.

2. Select a device in the Device Inventory table.

The Send System Logs link is enabled.
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3. Click Send System Logs.

The Collection Status column in the Device Inventory displays the status of the collection and 
upload of the system logs.

Enabling or disabling the automatic collection of system 
logs
By default, when a support case is opened or updated, SupportAssist is configured to automatically 
collect the system logs from the device that generated the alert and upload it to Dell.

To enable or disable the automatic collection of system logs:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Preferences page is displayed.

3. Under Support Collection, select or clear Automatically start a log collection when a new support 
case is generated, to enable or disable the automatic collection of system logs.

NOTE: By default, the Automatically start a log collection when a new support case is 
generated option is selected.

4. Click Save Changes.

Related Links

Preferences

Enabling or disabling the scheduling of system log 
collection
By default, SupportAssist is configured to collect the system logs from supported devices at periodic 
intervals and upload it to Dell. For information about the default frequency of the collection of system 
logs, see Default system log collection schedule. You can also customize the frequency of the collection 
of system logs for each device type. For more information, see Scheduling the periodic collection of 
system logs.

To enable or disable the scheduling of system log collection:

NOTE: Selecting the Enable system log collection scheduling option enables the collection and 
upload of system logs at periodic intervals from all supported device types. If you do not want 
SupportAssist to collect the system logs for a specific device type, you can disable scheduling for 
that specific device through the System Logs tab. For more information, see Disabling scheduling of 
system log collection for a specific device type.

To enable scheduling of system log collection:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.
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The System Logs page is displayed.

2. Click Preferences.

The Preferences page is displayed.

3. Under Support Collection, select or clear Enable system log collection scheduling, to enable or 
disable scheduling of the collection of system logs.

NOTE: By default, the Enable system log collection scheduling option is selected.

4. Click Save Changes.

Related Links

Preferences

Disabling the scheduling of system log collection for a specific device type

Scheduling the periodic collection of system logs
Before you begin, ensure that the Enable system log collection scheduling option is enabled in the 
Preferences page.

NOTE: To receive the full benefits of the support, reporting, and maintenance offering of your 
ProSupport Plus service contract, you must configure SupportAssist to collect the system logs at 
periodic intervals for each supported device type.

To schedule the periodic collection of system logs:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Under Edit Device Type Credentials, select the Device Type from the list. You can select from:

• Server

• Storage

• Switch

3. Select the Credential Type from the list. The options listed vary based on the Device Type you 
selected.

The options for Server are:

• Windows

• Linux

• ESX/ESXi

• iDRAC

• CMC

The options for Storage are:

• EqualLogic

• MD Series

The option for Switch is Dell Networking.

4. Verify or provide the credentials (Username, Password, Confirm Password, Community String) for 
the selected credential type. For more information, see Configuring the default device type 
credentials.
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5. Under System Log Collection Schedule, set the Frequency to Weekly or Monthly.

NOTE: If you want to disable the scheduling of system logs for a specific Device Type and 
Credential Type, set the Frequency to None.

6. In the Specify date and time fields, select an appropriate schedule. The options available vary based 
on the selected Frequency.

7. Repeat step 2 to step 5 until you have scheduled the periodic collection of system logs for all device 
types in your environment.

8. Click Save Changes.

Related Links

System Logs

Default system log collection schedule

Disabling the scheduling of system log collection for a specific device type

Default system log collection schedule

The following table provides the default system log collection schedule for each supported device.

Device Type Device or Operating System Schedule

Server Windows Monthly; Monday of the first 
week at 12:00 AM

Linux Monthly; Monday of the first 
week at 12:00 AM

ESX/ESXi Monthly; Monday of the first 
week at 12:00 AM

iDRAC Monthly; Monday of the first 
week at 12:00 AM

CMC Monthly; Monday of the first 
week at 12:00 AM

Storage Dell EqualLogic Weekly; Monday at 12:00 AM

Dell PowerVault MD series Weekly; Monday at 12:00 AM

Switch Dell Networking Monthly; Monday of the first 
week at 12:00 AM

Related Links

Scheduling the periodic collection of system logs

Disabling the scheduling of system log collection for a specific device type

Disabling the scheduling of system log collection for a 
specific device type
To disable the scheduling of system log collection for a specific device type:
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NOTE: Disabling the scheduling of system log collection for a specific device type only disables the 
generation of system log collection at periodic intervals on those devices. It does not disable 
SupportAssist from generating a system log collection and uploading it to Dell, if a support case is 
opened for those devices.

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Under Edit Device Credentials, select the Device Type for which you want to disable scheduling. 
You can select from:

• Server

• Storage

• Switch

3. Select the Credential Type for which you want to disable scheduling. The options available vary 
based on the Device Type you selected.

4. In System Log Collection Schedule section, set the Frequency to None.

5. Click Save Changes.

The following message is displayed in the System Log Collection Schedule section: System Log 
Collection scheduling is turned off for the current Device Type and 
Credential Type.

Related Links

Default system log collection schedule

Scheduling the periodic collection of system logs

Enabling or disabling the scheduling of system log collection

Viewing the case list
To view the Case List, click the Cases tab on the SupportAssist dashboard.

NOTE: By default, the case list is sorted by Date Opened, in descending order.

NOTE: Pre-existing support cases (opened prior to SupportAssist installation), and cases opened by 
contacting Dell technical support, do not appear in the Case List report.

Support case information is automatically available, for supported devices with valid Service Tags when 
SupportAssist connects to the Dell support case and service contract databases over the Internet.

NOTE: If you do not have Internet access, case information is not populated. It is downloaded and 
displayed when you connect to the Internet and open the Case List report.

Once SupportAssist has completed its open support cases update, the Case List displays the current 
cases.

Related Links

Case List

Filtering the displayed data

Removing filters from the displayed data

Sorting the displayed data
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Viewing the device inventory
The Device Inventory page displays the supported devices that are discovered in OpenManage Essentials.

To view the Device Inventory page, click the Devices tab on the SupportAssist dashboard. The device 
inventory displays the list of devices as groups.

If no device group is created, below the column headers, the device inventory displays Ungrouped 
devices (Total devices: n) and the list of devices.

If device groups are created, for each device group, the device inventory displays <Device Group Name> 
(Total devices: n) and the list of devices in the group. Devices that are not grouped are displayed below 
the existing device groups.

To collapse the list of devices displayed in a group, click the collapse icon .

To expand the list of devices in a group, click the expand icon .

NOTE: The Device Inventory is refreshed automatically every 5 minutes. If you select a device and 
the data is refreshed, the device is deselected. If you want to perform any operation on that device, 
you must select the device again.

Related Links
Device Inventory
Filtering the displayed data
Removing filters from the displayed data
Sorting the displayed data
Error code appendix

Filtering the displayed data
You can filter the data displayed in the Device Inventory, Case List, and the device group Manage 
Devices pages based on your preference.
To filter the displayed data:

1. Click the filter icon  displayed in the column header.

The filter options are displayed.

2. Select the appropriate filter option.

3. Type or select filtering criteria.

4. Click Filter.

The displayed data is filtered based on the selected or provided criteria. The column header displays 

the filtered icon .

Filtering options

The following are the filtering options displayed when you click the filter icon . The options displayed 
may vary based on the data you want to filter.
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Filtering option Description

Contains Select to filter the data based on alphanumeric characters provided in the field.

Equals Select to filter data that is the same as the value selected in the Select value drop-
down list.

Is equal to Select to display support cases opened on the date you select.

Is not equal to Select to display support cases opened on any other date than the date you 
select.

Is after or equal to Select to display support cases opened after or on the date you select.

Is after Select to display support cases opened after the date you select.

Is before or equal 
to

Select to display support cases opened after or on the date you select.

Is before Select to display support cases opened before the date you select.

Removing filters from the displayed data
You can remove the filters that you applied if you want to view the complete data again.
To remove filters from the displayed data:

1. Click the filtered icon  displayed in the column header.

The filter options are displayed.

2. Click Clear.

The complete data is displayed.

Sorting the displayed data
To sort the displayed data in the Case List, Device Inventory, or Device Groups pages, click a column 
header. The displayed data is sorted and an arrow that indicates the sorting type (ascending or 
descending) is displayed next to the column title.

To reset the sorting, click the column header again.

Device grouping (optional)

The device grouping feature enables you to create logical groups of devices. Creating a device group 
facilitates easier management of devices. For example, you can create logical groups of devices based 
on:

• Device type (server, storage, or switch)

• Physical location of the devices (shipping address)

• The individual who manages the devices (Administrator group)

• Organization or business unit

• Alerting or notification

After you create a device group, you can:
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• Manage Devices — Add or remove devices from the device group.

• Manage Credentials — Configure credentials for each device type included in the device group.

• Manage Contacts — Configure the contact information and parts dispatch information for the device 
group.

• Edit/Delete Group — Edit the device group details or delete the device group.

NOTE: You can create and manage device groups only if you are logged on as a member of the 
OpenManage Essentials Administrators, Power Users, or Site Administrators group.

NOTE: The device group credentials, contact information, and parts dispatch information override 
the default credentials, contact information, and parts dispatch information configured through the 
Settings page. For example, if you have created a device group and configured the primary contact 
for the device group, all SupportAssist notifications for issues with any device included in the device 
group are sent to the primary contact assigned to that device group.

NOTE: Grouping of devices is optional. It does not have an impact on the monitoring and automatic 
case creation capabilities of SupportAssist.

Related Links

Viewing device groups

Creating a device group

Managing devices in a device group

Managing credentials of a device group

Viewing and updating the contact information of a device group

Editing device group details

Deleting a device group

Viewing device groups

The Device Groups page displays the device groups that you have created.
To view the device groups:

1. Click Devices.

The Device Inventory page is displayed.

2. Click Groups.

The Device Groups page is displayed.

Creating a device group

You can create a device group based on your requirement. For example, you can create device groups 
based on the device types.

NOTE: You can create device groups only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

To create a device group:

1. Click the Devices tab.

The Device Inventory page is displayed.

2. Click the Groups tab.

The Device Groups page is displayed.

3. Click Create Group.
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4. In the window that is displayed, provide a name and description for the group.

5. Click Save.

The device group that you created is displayed in the Device Groups page.

Managing devices in a device group

After creating a device group, you can select the devices you want to add or remove from the device 
group.
Before you begin, makes sure that you have already created a device group. See Creating a device group.

NOTE: You can add or remove devices from a device groups only if you are logged on as a member 
of the OpenManage Essentials Administrators, Power Users, or Site Administrators group.

To manage devices in a device group:

NOTE: A device can be included in only one device group.

NOTE: Only 100 devices can be added to a device group.

1. Click the Devices tab.

The Device Inventory page is displayed.

2. Click the Groups tab.

The Device Groups page is displayed.

3. Select a device group.

4. In the Select group actions drop down list, select Manage Devices.

The Manage Devices window is displayed.

5. To add devices to the device group, select devices in the Ungrouped Devices pane, and click  .

The selected devices are moved to the Devices In Current Group pane.

6. To remove devices from the device group, select devices in Devices In Current Group pane, and 

click .

The selected devices are moved to the Ungrouped Devices pane.

7. Click Save.

Managing credentials of a device group

If the credentials of the device types in a device group differ from the default credentials, you must 
provide the credentials of those device types through the Manage Credentials window.

NOTE: You can manage credentials of a device group only if you are logged on as a member of the 
OpenManage Essentials Administrators, Power Users, or Site Administrators group.

NOTE: The device group credentials override the default credentials configured through the 
Settings → System Logs page. SupportAssist uses the device group credentials (not the default 
credentials) to run the collection component on devices included in the group.

To manage the credentials of a device group:

1. Click the Devices tab.

The Device Inventory page is displayed.

2. Click the Groups tab.

The Device Groups page is displayed.

3. Select a device group.
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4. In the Select group actions drop down list, select Manage Credentials.

The Manage Credentials window is displayed.

5. Type the user name and password of the device type highlighted in the left pane.

6. If more than one device type is included in the device group, click Next.

The next device type is highlighted in the left pane.

7. Repeat step 5 and step 6 until you have provided the user name and password for all device types 
included in the device group.

8. Click Save.

Related Links

Device credentials used by SupportAssist

Viewing and updating the contact information of a device group

You can view or update the contact information, preferred contact method and time, and the parts 
dispatch information for a device group.

NOTE: You can update the contact information of a device group only if you are logged on as a 
member of the OpenManage Essentials Administrators, Power Users, or Site Administrators group.

NOTE: The device group contact information overrides the default contact information configured 
through the Settings → Contact Information page. If there is a problem with devices included in 
group, SupportAssist sends notifications to the device group contact (not the default contact).

To update the contact information of a device group:

1. Click the Devices tab.

The Device Inventory page is displayed.

2. Click the Groups tab.

The Device Groups page is displayed.

3. Select a device group.

4. In the Select group actions drop down list, select Manage Contacts.

The Manage Contacts window is displayed.

5. If you want to use the contact information provided in the Settings → Contact Information page, 
select Use Default.

6. Select the type of contact:

• Primary

• Secondary

7. Type the first name, last name, phone number, alternate phone number (optional), and e-mail 
address in the appropriate fields.

8. Select the preferred contact method, preferred contact hours, and time zone.

9. In the Parts Dispatch (Optional) section:

NOTE: The parts dispatch information is optional. If the Dell technical support agent determines 
that a part needs to be replaced in your environment to resolve a support case, the 
replacement part is dispatched with your consent to the provided address.

NOTE: The device group parts dispatch information overrides the default parts dispatch 

information configured through the Settings → Contact Information page. If resolving a 
problem requires replacing a part, the replacement part is shipped with your consent to the 
device group parts dispatch address (not the default parts dispatch address).
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a. Type the address and city/town in the appropriate fields.

b. Select the country.

c. Type the state/province/region and zip/postal code in the appropriate fields.

10. Click Save.

Editing device group details

You can edit the name and description of a device group based on your preference.

NOTE: You can edit the device group details only if you are logged on as a member of the 
OpenManage Essentials Administrators, Power Users, or Site Administrators group.

To edit the device group details:

1. Click the Devices tab.

The Device Inventory page is displayed.

2. Click the Groups tab.

The Device Groups page is displayed.

3. Select a device group.

4. In the Select group actions drop down list, select Edit/Delete Group.

5. In the window that is displayed, edit the name and description based on your preference.

6. Click Update.

Deleting a device group

You can delete device groups based on your preference.

NOTE: You can delete a device group only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

NOTE: Deleting a device group only removes the device group, device group credentials, and 
contact information. It does not delete any devices from the Device Inventory page.

To delete a device group:

1. Click the Devices tab.

The Device Inventory page is displayed.

2. Click the Groups tab.

The Device Groups page is displayed.

3. Select a device group.

4. In the Select group actions drop down list, select Edit/Delete Group.

5. In the window that is displayed, click Delete.

Device credentials used by SupportAssist

SupportAssist uses the credentials you configured for the devices to run the collection components and 
collect the system logs. You may have configured the credentials for devices through the following 
options:

• Default credentials — Configured through the Default Device Type Credentials option in the System 
Logs page.
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• Device-specific credentials — Configured through the Edit Credentials option in the Device 
Inventory page.

• Device group credentials — Configured through the Manage Credentials option in the Device Groups 
page.

SupportAssist uses the configured credentials based on the following order of priority:

1. Device-specific credentials

2. Device group credentials

3. Default credentials

For example:

• If you have configured the credentials for a device through all the options listed earlier, the device-
specific credentials is used for running the collection components.

• If you have configured the default credentials and device group credentials, the device group 
credentials is used for running the collection components.

Related Links

Editing device credentials

Managing credentials of a device group

Configuring the default device type credentials

Configuring the system credentials
System credentials refers to the credentials of a user account that is a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group. SupportAssist requires the system 
credentials to connect to OpenManage Essentials for retrieving device and alert information.

To configure the system credentials:

NOTE: If you change the system credentials because of the security policy requirements of your 
company or for other reasons, you must ensure that the System Credentials are also updated in 
SupportAssist. Alternatively, you can create a service account that never expires, and provide the 
service account credentials in SupportAssist.

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click System Credentials.

The System Credentials page is displayed.

3. Type the user name, password, and confirm the password in the appropriate fields.

NOTE: The user account must be a member of the OpenManage Essentials Administrators, 
Power Users, or Site Administrators group.

4. Click Save Changes.
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Auto update
NOTE: It is recommended that you enable auto update to ensure that SupportAssist is up-to-date 
with the latest features and enhancements.

The auto update feature, when enabled, ensures that SupportAssist and the associated collection 
components are automatically updated, when an update is available. By default, the SupportAssist 
application checks if any updates are available, every Monday at 11 am (management server date and 
time). If updates are available:

• If auto update is enabled, the updates are downloaded and automatically installed in the background.

• If auto update is disabled, the Update Available notification window is displayed. You can click Install 
to download and install the latest updates.

To enable auto update, see Enabling auto update.

If you click Cancel in the Update Available notification window or an error occurs during the update 

process, on refreshing the web browser, the  Update Available notification is displayed in the 
SupportAssist header. You can click the Update Available notification to download and install the updates 
at a later time.

NOTE: After the updates are downloaded and installed, an update successful message is displayed. 
To view and use the latest updates and enhancements, you must refresh the SupportAssist 
dashboard.

The log file, AutoUpdate-log-file.txt, related to the SupportAssist update can be located at C:\Program 
Files (x86)\Dell\Dell Integrated Support\logs.

Enabling auto update

To enable auto update:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Auto Update,Email Settings, Support Collection, and Maintenance Mode page is displayed.

3. Under Auto Update, select Enable auto update.

4. Click Save Changes.

Related Links

Preferences

Configuring proxy server settings

If your system connects to the Internet through a firewall or proxy server, the proxy settings must be 
configured in SupportAssist. Configuring the proxy settings enables the SupportAssist application to 
communicate with the SupportAssist server hosted by Dell.
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To configure the proxy server settings:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Proxy Settings.

The Proxy Settings page is displayed.

3. Select Use Proxy Settings.

NOTE: SupportAssist supports Windows NT LAN Manager (NTLM) authentication protocol only.

4. Type the Proxy Server Address or Name and Proxy Port Number details.

NOTE: If the proxy server credentials are not provided, SupportAssist connects to the proxy 
server as an anonymous user.

5. If the proxy server requires authentication, select Proxy requires authentication, and then provide 
the following information in the corresponding fields:

• Username — The user name must contain one or more printable characters, and not exceed 104 
characters.

• Password — The user password must contain one or more printable characters, and not exceed 
127 characters.

• Confirm Password — Repeat the user password. The password should match with the one 
provided in the Password field.

6. Click Apply.

SupportAssist tests the proxy server settings, and the result of the test is displayed in a dialog box.

Related Links
Proxy Settings

Confirming connectivity through the proxy server

To test if SupportAssist can connect to the Internet through the proxy server:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Proxy Settings.

The Proxy Settings page is displayed.

3. Ensure that the proxy settings has been configured correctly. See Configuring proxy server settings.

4. Click Apply.

A dialog box appears to inform the status of the connection through the proxy server.

Configuring e-mail notification settings

You can configure the e-mail notification settings based on your:

• Preference to receive e-mail notifications from SupportAssist
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• Preferred language

To configure the e-mail notification settings:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Auto Update, Email Settings, Support Collection, and Maintenance Mode page is displayed.

3. To receive e-mail notifications when a new support case is opened, under Email Settings, select 
Receive email notification when a new support case is opened.

NOTE: Disabling support case e-mail notifications also disables e-mail connectivity test e-mails.

4. To set the language in which you want to receive e-mail notifications, from the Preferred Email 
Language list, select a language.

NOTE: The Preferred Email Language is enabled only when the Receive email notification 
when a new support case is opened option is selected.

5. Click Save Changes.

Related Links

Preferences

Setting SupportAssist to maintenance mode

SupportAssist can also be set in or out of Maintenance Mode. Maintenance Mode disables automatic case 
generation activity, thereby allowing you to make infrastructure changes without generating unnecessary 
alerts.

To set SupportAssist in or out of Maintenance Mode:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Preferences.

The Auto Update, Email Settings, Support Collection, and Maintenance Mode page is displayed.

3. Under Maintenance Mode, select or clear Temporarily suspend case generation activity (for 
example, for purposes of downtime, external troubleshooting, etc.) to toggle the Maintenance 
Mode status.

• If you select this option, SupportAssist is placed in maintenance mode.

• If you clear this option, SupportAssist is taken out of maintenance mode.

4. Click Save Changes.

A banner appears along the top of the SupportAssist dashboard displaying Maintenance Mode.

Once manually placed in maintenance mode, SupportAssist remains in that state unless you clear the 
option as in step 3.
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NOTE: The Maintenance Mode functionality, when set manually, differs from the manner in 
which the Maintenance Mode feature handles event storms. See Event Handling for more 
information.

Related Links

Preferences

Viewing and updating the contact information

To view and update the contact information:

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

1. Click the Settings tab.

The System Logs page is displayed.

2. Click Contact Information.

The Contact Information page is displayed.

3. If required, edit the company name.

4. Select the type of contact:

• Primary

• Secondary

5. Type the first name, last name, phone number, alternate phone number (optional), and e-mail 
address in the appropriate fields.

6. Select the preferred contact method, preferred contact hours, and time zone.

7. In the Parts Dispatch (Optional) section:

NOTE: The parts dispatch information is optional. If the Dell technical support agent determines 
that a part needs to be replaced in your environment to resolve a support case, the 
replacement part is dispatched with your consent to the provided address.

a. Type the address and city/town in the appropriate fields.

b. Select the country.

c. Type the state/province/region and zip/postal code in the appropriate fields.

8. Click Save Changes.

Related Links

Contact Information

Accessing and viewing the logs

The SupportAssist dashboard stores Windows events and log messages in two locations:

• The Windows Event Log

• The dashboard installation logs directory (typically, C:\Program Files (x86)\Dell\Dell Integrated 
Support\logs.
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A new log is created daily at 11:59 PM as per the time zone configured in the system, and is stored in the 
logs directory with the date appended to the file extension. This enables you to identify the exact log file 
stored for a given date when alerts occur. For example, log files similar to the following can be seen:

• log-file.txt 20120226

• log-file.txt 20120227

• log-file.txt 20120228

Log files are purged from storage after 45 days.

To view the Windows Event Log, invoke the Event Viewer application and then expand Applications and 
Services Logs. The DellIntegratedSupport log file contains entries from the dashboard service. The 
dashboard logs messages here that correspond to the value of the Windows Registry key, 
WindowsEventLogLevel, or higher.

In the dashboard installation directory, you can view one log file per day. The current log file is named 
log-file.txt, and contains log messages that correspond to the following values (or higher) in the Windows 
Registry key LogFileLevel: FATAL, ERROR, WARN, INFO, and DEBUG, with special values of OFF and ALL. A 
registry value of ERROR results in logs messages of FATAL, and ERROR, since FATAL is a higher level than 
ERROR.

The LogFileLevel Windows Registry key can be located at HKEY_LOCAL_MACHINE\SOFTWARE
\Wow6432Node\Dell\Dell Integrated Support.

Accessing and viewing the system log collection

When a support case is automatically generated by SupportAssist, data required to troubleshoot the issue 
is collected and sent to Dell technical support. The collected troubleshooting information is also 
compressed and stored on your OpenManage Essentials server at C:\Program Files (x86)\Dell\Dell 
Integrated Support\reports.

The filename includes the device’s IP address, Dell service tag, and the date/time when the file was 
created. For example:

• DSET_Report_for[192.168.1.254_SvcTag_AL12G26_2012-03-07T132648].zip

• Periodic_DSET_Report_for[192.168.1.254_SvcTag_AL12G26_2012-03-07T132648].zip

• Lasso_Report_for[10.94.216.76_SvcTag_897672S_2012-08-21T094147].zip.gpg (without PII)

• Lasso_Report_for[10.94.216.76_SvcTag_897672S_2012-08-21T094147].xml.gpg (with PII)

The report file is encrypted with the password, dell (all lowercase). The report information can then be 
viewed by opening the dsetreport.hta file in your web browser.

NOTE: You should open the reports only when asked to do so by Dell technical support. Your 
report will not be reviewed unless you have an open support case.

Viewing SupportAssist product information
The About window displays the SupportAssist product version, copyright information, and detailed 
SupportAssist feature descriptions.
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To view general and detailed SupportAssist product information:

1. Move the mouse pointer over the Help link at the top-right corner of the SupportAssist dashboard, 
and then click About.

The About window is displayed, where you can view the general and detailed product information 
and also the copyright information.

2. Click Close to return to the SupportAssist dashboard.

Viewing support information

The Help window displays SupportAssist product version and copyright information, and provides access 
to Dell Technical Support and Dell OpenManage Essentials information.

To view the support information for SupportAssist:

1. Move the mouse pointer over the Help link at the top-right corner of the SupportAssist dashboard, 
and then click Help.

The Help window is displayed.

2. In the Help window :

• Read the General product and copyright information.

• Click the links under Dell SupportAssist Additional Information & Updates to view:

– Dell Technical Support launch points, community forums, blogs, and much more

– Dell product manuals for hardware and software products

• Click the link under Dell OpenManage Essentials (OME) Additional Information & Updates to 
view Dell OpenManage Essentials Frequently Asked Questions, updates, videos, and so on.

3. Click Close to return to the SupportAssist dashboard.

Accessing the context-sensitive help
The context-sensitive help provides information about features and tasks that are applicable to the 
current view on the dashboard. Once you invoke the context-sensitive help, you can navigate or search 
through the entire SupportAssist help system.

To access the context-sensitive help, click the  icon that appears in the dashboard. The context-
sensitive help is displayed in a new browser window.
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4
Troubleshooting
The following sections describe procedures you can use to troubleshoot Dell SupportAssist issues

Installing SupportAssist

SupportAssist installation requires elevated Microsoft User Authentication (UAC) privileges, and may fail if 
you attempt to install by double-clicking on the installer executable. If this occurs, install SupportAssist as 
follows:

1. Right-click the installer executable.

2. Select Run as administrator.

NOTE: SupportAssist installation requires that you allow Dell to save certain Personally 
Identifiable Information (PII) such as your contact information and local administrator 
credentials, and so on. SupportAssist installation cannot proceed unless you allow Dell to save 
your PII.

Registration problem
The SupportAssist Setup Wizard guides you through the registration of SupportAssist. If the registration is 
successful:

• A registration confirmation e-mail is sent to your primary contact.

• The Registration ID value is displayed in the SupportAssist Help → About window.

Registration problem occurs if the SupportAssist application has problems communicating with the 
SupportAssist server hosted by Dell. To resolve the communication problems, see Ensuring Successful 
Communication Between The SupportAssist Application And The SupportAssist Server.

Ensuring successful communication between the 
SupportAssist application and the SupportAssist server

The SupportAssist application installed on the management server must be able to communicate with the 
SupportAssist server hosted by Dell to:

• Automatically create a support case if there is a problem with a device in your environment.

• Upload the generated system log collection to Dell.
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To ensure that the SupportAssist application is able to successfully communicate with the SupportAssist 
server:

• The management server on which the SupportAssist application is installed must be able to connect 
to the following destinations:

– https://api.dell.com/support/case/v2/WebCase — end point for the SupportAssist server. On the 
management server, verify if you can access the following location using the web browser: 
https://api.dell.com/support/case/v2/WebCase?wsdl.

– https://ddldropbox.us.dell.com/upload.ashx/ — the file upload server where the diagnostic test 
results are uploaded.

– Verify if port 443 is open on the management server for ddldropbox.us.dell.com and ftp.dell.com. 
You can use a telnet client to test the connection. For example, use the following command: o 
ddldropbox.us.dell.com 443.

– https://ftp.dell.com/ — for new SupportAssist release information. On the management server, 
verify if you can access the following location using the web browser: https://ftp.dell.com/.

• Verify if the server certificate on ddldropbox.us.dell.com is valid. For more information, see Verifying 
the server certificate.

• Verify if the network settings on the management server are correct.

• If the management server on which SupportAssist is installed connects to the Internet through a proxy 
server, configure the proxy settings in SupportAssist. See Configuring proxy server settings.

If the communication problem persists, contact your network administrator for further assistance.

Verifying the server certificate

To verify the server certificate on ddldropbox.us.dell.com:

1. Open https://ddldropbox.us.dell.com in a web browser.

A 404 — File or directory not found error may be displayed.

2. On the address bar, click the Security Report icon , and then click View Certificates.

The Certificate is displayed.

3. In the General tab, verify if the certificate displays a valid date.

4. Click the Certification Path tab, and verify if the GTE CyberTrust Global root certificate is listed.

Verifying the installation of the collection components
SupportAssist uses the following collection components to generate the system log collection from 
supported devices in an environment:

• Dell System E-Support Tool (DSET)

• Dell Lasso

The collection components are automatically downloaded and installed in the background after the 
installation of SupportAssist. To successfully generate the system log collection, the collection 
component must be of a version that is compatible with SupportAssist.

To verify if a compatible version of the collection component is installed:

1. Navigate to the Control Panel.

2. Click Programs → Programs and Features.
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The Uninstall or change a program window is displayed.

3. In the list of installed applications, verify if the compatible version of DSET and Lasso are installed.

NOTE: For information on the version of DSET and Lasso that is compatible with SupportAssist, 
see the Dell SupportAssist Support Matrix at Dell.com/ServiceabilityTools.

Launching SupportAssist
If you see a Problem starting the Dell SupportAssist Service error upon launching 
SupportAssist:

• There may be a Microsoft Windows registry configuration problem with the SupportAssist Windows 
service. To resolve this issue, uninstall and then reinstall SupportAssist.

• The SupportAssist dashboard requires some DLLs that are installed in OpenManage Essentials. The 
SupportAssist installer checks that OpenManage Essentials is installed, and then checks the 
OpenManage Essentials version. If the DLLs are manually removed, the following error appears during 
installation:

Error 1920. Service Dell SupportAssist Service (PhomePluginWindowsService) 
failed to start.
If this occurs:

– Verify that you have sufficient privileges to start system services.

– Check the log-file.txt file in the logs directory (typically, C:\Program Files (x86)\Dell\Dell Integrated 
Support\logs) to see which component failed to load.

Services
• The SupportAssist application installed on the management server may not initially connect to the 

SupportAssist server hosted by Dell if your network requires passing web browser traffic through a 
proxy server. If this occurs:

– A dialog box may be displayed prompting you to configure your proxy settings. Provide the 
information required in the appropriate fields to connect to the SupportAssist server through your 
proxy server.

– Configure the proxy server settings in SupportAssist. See Configuring proxy server settings.

– After configuring the proxy server settings, verify if the SupportAssist application can connect to 
the SupportAssist server through the proxy server by performing the connectivity test. See 
Performing the connectivity test.

• If the SupportAssist dashboard application does not seem to connect to the SupportAssist server or 
behave appropriately, ensure that the SupportAssist Windows service is running:

1. Click Start → Run.

The Run dialog box is displayed.

2. Type services.msc, and then click OK.

The Services Microsoft Management Console (MMC) is displayed.

3. Check if the Dell SupportAssist Service displays the status as Running.

4. If the service is not running, start the service by right-clicking Dell SupportAssist Service → Start.

5. If the service cannot or does not start, open the most recent log file (log-file.txt), and then search for 
text with a timestamp of when you tried to start the service. The log file may contain a message 
indicating any dashboard startup errors and a possible problem diagnosis.

6. To verify that the SupportAssist application can connect to the SupportAssist server hosted by Dell , 
perform the connectivity test. See Performing the connectivity test.
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• If the server is responding, a success message is displayed in the dashboard. If not, the server may 
not be functional. If this occurs, look through the log-file.txt file, typically located at C:\Program 
Files (x86)\Dell\Dell Integrated Support\logs to find details. If there are no discernible details in 
the log file, and the server is not reachable, contact Dell technical support.

• If communication is successful, but no data updates occur, the dashboard may be identifying 
itself with an ID that is unknown to the server. If this occurs, look through the log-file.txt log file, 
typically located in C:\Program Files (x86)\Dell\Dell Integrated Support\logs to find details. The 
log file may contain a message stating that the dashboard was not recognized. If the dashboard is 
not recognized by the SupportAssist server, uninstall and reinstall SupportAssist.

The SupportAssist dashboard registers as a new client, enabling the SupportAssist server to recognize 
it.

Collection error
If you receive a SupportAssist e-mail notification indicating a collection issue with a specific device and 

the Status of the device displays  Error:

1. Click the Error link in the Status column to view the possible resolution steps.

2. Verify if the device is connected to the network.

3. Verify the credentials you have provided for the device. You must provide the Administrator 
credentials in the Settings → System Logs page. For more information, see Configuring the default 
device type credentials and Editing device credentials.

Collection upload error
If you receive a SupportAssist e-mail notification indicating an issue uploading the collection for a specific 

device and the Status of the device displays  Error:

1. Click the Error link in the Status column to view the possible resolution steps.

2. Verify if the management server on which SupportAssist is installed is able to connect to the Internet.

3. If the management server on which SupportAssist is installed connects to the Internet through a 
proxy server, ensure that you configure the proxy settings in SupportAssist. For more information, see 
Configuring proxy server settings.

4. Perform the connectivity test and make sure that the test is successful. For more information, see 
Performing the connectivity test.

5. Verify if the SupportAssist application is able to communicate successfully with the SupportAssist 
server. See Ensuring successful communication between the SupportAssist application and the 
SupportAssist server.

After resolving the issue, manually upload a new collection for the device to Dell. For more information, 
see Sending the system logs manually.

Security
• The Settings tab is inaccessible and the Connectivity Test link is disabled. On clicking Settings tab, a 

dialog box is displayed with the following message: Access Denied. You must be logged in 
as a member of the Dell OpenManage Essentials Administrators or Power Users 
group to access this content.

• The Edit Device Credentials and Send System Logs links remain disabled even after selecting a device 
in the Device Inventory.
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If this occurs, ensure that you are logged on as a member of the OpenManage Essentials Administrators, 
Power Users, or Site Administrators group.

Troubleshooting SSL connection failure
SSL connection failure may occur if the system does not have the required certificate installed from the 
issuing root certificate authority — GTE CyberTrust Global Root. All Dell certificates are issued from this 
certificate authority.

To verify if the certificate is installed in Internet Explorer:

1. Click Tools → Internet Options.

The Internet Options dialog box is displayed.

2. Click the Content tab, and then click Certificates.

The Certificates dialog box is displayed.

3. Click the Trusted Root Certification Authorities tab.

4. Scroll to verify if GTE CyberTrust Global Root is listed in the Issued To and Issued By columns.

If GTE CyberTrust Global Root is not listed, you must install the required certificates. See Exporting the 
root certificate and Installing the root certificate.

Exporting the root certificate

To export the root certificate:

1. In Internet Explorer, go to https://dell.com.

2. If the Certificate Error: Navigation Blocked page is displayed, click Continue to this website (not 
recommended).

3. At the Do you want to view only the webpage content that was delivered securely? prompt, click 
Yes.

4. On the address bar, click the Security Report icon .

5. Click View certificates.

The Certificate window is displayed.

6. Click Details.

7. Click Copy to File.

The Certificate Export Wizard is displayed.

8. Click Next.

9. In the Export File Format page, click Next.

10. In the File to Export page, click Browse.

The Save As window is displayed.

11. Navigate to the location you want to save the certificate file.

12. Type a file name and click Save.

13. In the Export File Format page, click Next.

14. Click Finish.

The status of the export is displayed.

15. Click OK.
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Installing the root certificate

Before you begin, ensure that:

• You are logged on using the user account with which SupportAssist was installed.

• You have administrator privileges.

• The SupportAssist service is running.

• You have exported the certificate file. See Exporting the root certificate.

To install the root certificate:

1. Click Start → Run.

The Run dialog box is displayed.

2. In the Open box, type mmc and click OK.

The Console1 – [Console Root] window is displayed.

3. Click File → Add/Remove Snap-in.

The Add or Remove Snap-ins dialog box is displayed.

4. Under Available snap-ins, select Certificates, and click Add >.

The Certificates snap-in dialog box is displayed.

5. Ensure that My user account is selected, and then click Finish.

6. In the Add or Remove snap-ins dialog box, click Add >.

The Certificates snap-in dialog box is displayed.

7. Select Computer account and click Next.

The Select Computer dialog box is displayed.

8. Ensure that Local computer: (the computer this console is running on) is selected and click Finish.

9. In the Add or Remove snap-ins dialog box, click OK.

10. Under the Console Root, click Certificates – Current User.

11. Right-click Trusted Root Certification Authorities → All Tasks → Import.

The Certificate Import Wizard is displayed.

12. Click Next.

The File to Import dialog box is displayed.

13. Browse to select the exported certificate file and click Next.

The Certificate Store information is displayed.

14. Click Next.

15. Click Finish.

16. Right-click Intermediate Certification Authorities → All Tasks → Import.

The Certificate Import Wizard is displayed.

17. Browse to select the exported certificate file and click Next.

The Certificate Store information is displayed.

18. Click Next.

19. Click Finish.

20. Under the Console Root, click Certificates (Local Computer).

21. Perform step 11 to step 19 to install the root certificate.
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Service contract

The Service Contract column on the Case List report, may display a warning icon or Unknown. See the 

following sections for more information about these messages.

Service contract warning

A warning icon may appear in the Service Contract column of some cases if the associated device is not 
covered under a Dell service contract or the service contract has expired.

If any cases display a warning icon in the Service Contract column:

1. Move the pointer over the warning icon to display a tool tip.

2. Click the Dell Support link displayed in the tool tip to open the service contract information page.

You can obtain current service contract information for your Dell devices, obtain new service contracts, 
and so on.

Service contract type is unknown

The Service Contract column on Case List report displays unknown for all existing support cases.

This issue occurs when you upgrade SupportAssist. Once an alert is received from the device, the Service 
Contract column is updated with the appropriate service contract type.

Service Tag warnings
On rare occasions some cases may display an invalid Dell Service Tag warning.

To resolve Service Tag warnings:

1. Identify the Service Tag for your device.

2. Contact Dell technical support. See Contacting Dell.
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5
Dell SupportAssist user interface
The top-right of the SupportAssist header area displays links that you can use to navigate the interface. 
The following table describes the links that are displayed.

Link Description

SupportAssist 
Community

Opens the SupportAssist User Group website in a new browser window.

Help Move the mouse pointer over the link to display a drop-down that provides the 
following options:

• Help — Opens the Help window that provides links to Dell technical support 
and product manuals.

• About — Opens the About window that provides information about the 
SupportAssist version, copyright information, and also notifies if a newer 
version of SupportAssist is avaialable.

User name Displays the user name of the currently logged in user. Move the mouse pointer 
over the user name link to display a drop-down that contains a link to the 
Connectivity Test page.

 Update 
Available

Displays in the SupportAssist header area in the following situations:

• If an error occurred during the update of SupportAssist.

• If the Settings → Preferences → Enable auto update option is not selected, 
and you cancel the SupportAssist Update notification that is displayed.

You can click the link to download and install the SupportAssist update.

NOTE: The Update Available link is displayed only if you are logged in as a 
member of the Dell OpenManage Essentials Administrators, Power Users, or 
Site Administrators group.

The SupportAssist dashboard displays the following tabs that enable you to view the support cases, 
monitored devices, and configuration options:

• Cases — Displays the support cases that are open.

• Devices — Displays the following tabs:

– Inventory — Displays the supported devices that are discovered in OpenManage Essentials.

– Groups — Displays the device groups that you have created.

• Settings — Displays the setting options for configuring the default device credentials, proxy settings, 
preferences, contact information, system credentials, and SMTP settings.

NOTE: The Settings tab is accessible only if you are logged on as a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

Related Links
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Case List

Device Inventory

Device grouping (optional)

Settings

Connectivity Test

Auto update

Case List

The Case List is the default view of SupportAssist.

The following table describes the automatically-generated support case information for the supported 
Dell devices in your environment, as displayed in the Case List page.

Column Description

Case Status Displays the current state of the support case. The status of a case may be:

• Open — Dell technical support has opened the submitted case.

• In Progress — The case is currently being worked by Dell technical support.

• Customer Deferred — Dell technical support has deferred the case at your 
request.

• Submitted — SupportAssist has submitted the case.

• No Case — No case exists for this device.

• Reopened — The case was previously closed, and has been reopened.

Case Number Displays the numeric identifier assigned to the support case.

Case Title Displays the case name, which identifies:

• Case generation method

• Device model

• Device operating system

• Alert ID, if available

• Alert description, if available

• Warranty status

• Resolution description

Service Contract Displays the Dell service contract level under which the device is covered. The 
service contract column may display:

• Unknown — SupportAssist cannot determine the service contract.

• Invalid Service Tag — The Service Tag of the device is invalid.

• No Service Contract — This device is not covered under a Dell service 
contract.

• Expired Service Contract — The service contract of the device has expired.

• Basic Support — This device is covered under a Dell Basic Hardware service 
contract.

• ProSupport — This device is covered under a Dell ProSupport service contract.

• ProSupport Plus — This device is covered under a Dell ProSupport Plus service 
contract.

Device Type Displays the type of device as discovered by OpenManage Essentials:
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Column Description

• PowerVault Storage Device — The device is a Dell PowerVault MD Series 
storage array.

• PowerVault Server — The device is a Dell PowerVault NX Network Attached 
Storage (NAS) device.

• EqualLogic Storage — The device is a Dell EqualLogic storage array.

• PowerEdge Server Device — The device is a Dell PowerEdge, PowerEdge 
VRTX, iDRAC, or CMC device.

• PowerEdge Direct Attached Storage — The device is a PowerVault MD or NX 
Direct Attached Storage (DAS) device.

• Dell Networking — The device is a Dell Networking switch.

Service Tag Displays a unique, alphanumeric identifier that enables Dell to individually 
recognize each Dell device.

Date Opened Displays the date and time when the support case was opened.

Device Inventory

The Device Inventory page displays the supported devices that are discovered in OpenManage Essentials. 
The device inventory displays the device list as a group.

If no device group is created, below the column headers, the device inventory displays Ungrouped 
devices (Total devices: n) and the list of devices.

If device groups are created, for each device group, the device inventory displays <Device Group Name> 
(Total devices: n) and the list of devices in the group. Devices that are not grouped are displayed below 
the existing device groups.

The following table describes the automatically-generated inventory information for your supported Dell 
devices, as displayed in the Device Inventory page.

Field Description

Edit Credentials Select a device and click Edit Credentials to edit the credentials for the selected 
device.

Send System Logs Select a device and click Send System Logs to generate a system log collection 
from the selected device and upload it to Dell.

Name Displays the NetBIOS name of the device as discovered by OpenManage 
Essentials.

Type Displays the type of device as discovered by OpenManage Essentials:

• PowerVault Storage Device — The device is a Dell PowerVault MD Series 
storage array.

• PowerVault Server — The device is a Dell PowerVault NX Network Attached 
Storage (NAS) device.

• EqualLogic Storage — The device is a Dell EqualLogic storage array.

• PowerEdge Server Device — The device is a Dell PowerEdge, PowerEdge 
VRTX, iDRAC, or CMC device.

• PowerEdge Direct Attached Storage — The device is a PowerVault MD or NX 
Direct Attached Storage (DAS) device.
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Field Description

• Dell Networking — The device is a Dell Networking switch.

Service Tag Displays a unique, alphanumeric identifier that enables Dell to individually 
recognize each Dell device.

Status Displays the status of the collection component installation, support case, device 
configuration, or system log collection. The status may be:

•  Installing Collection Component — Installation or update of the 
collection component is in progress.

•  Collection In Progress — The collection component is running on the 
device.

•  Collection Uploaded — The system log collection has been uploaded to 
Dell.

•  Device Configured — The device is configured correctly for monitoring 
using SupportAssist.

•  Collection Component Is Not Supported — The collection component is 
not supported on the device.

•  Unknown — The unknown status is displayed in any of the following 
scenarios:

– The device is setup, but the connectivity and collection capability of the 
device is to be verified.

– An unknown issue occurred while verifying the device status.

– The status of the device could not be verified within the predefined time 
limit.

•  Error — The error status is displayed in any of the following scenarios:

– Installation of the collection component is unsuccessful.

– The collection component is not installed.

– The support case information for the device could not be accessed by 
SupportAssist.

– The support case service hosted by Dell is currently unavailable.

– The collection component had started, but failed to run on the device.

– The system log collection was not successfully uploaded to Dell.

– The device or device type credentials are not configured.

– The device is not set up correctly. There may be an issue with either the 
configured credentials or connectivity.

NOTE: The Error status is displayed as a link that you can click to view the 
description of the issue and the possible resolution steps.

Related Links

Editing device credentials

Sending the system logs manually

Device grouping (optional)
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Error code appendix

Device Groups
The Device Groups page enables you to create and manage devices groups.

The following table provides information about the fields displayed in the Device Groups page.

Field Description

Create Group Click to create a device group.

Select group 
actions

Displays actions you can perform on the devices groups. The following are the 
actions you can select:

• Manage Devices — Displays the Manage Devices window that enables you to 
add or remove devices from a device group.

• Manage Credentials — Displays the Manage Credentials window that enables 
you to provide the credentials for the devices types included in a device group.

• Manage Contacts — Displays the Manage Contacts window that enables you 
to provide the contact information and parts dispatch information for each 
device type included in a device group.

• Edit/Delete Group — Displays a window that enables you to edit the group 
details or delete a device group.

Name Displays the name of the device group and the total number of devices in the 
device group.

Description Displays the description provided for the device group.

Related Links

Viewing device groups

Creating a device group

Manage Devices

The Manage Devices window enables you to add or remove devices from a device group.

On the Manage Devices window:

• The Ungrouped Devices pane displays all devices that are not included in any device group.

• The Devices in Current Group pane displays devices that are included in the current device group.

The following table provides information about the fields displayed in the Manage Devices window.

Field Description

Name Displays the NetBIOS name of the device as discovered by OpenManage 
Essentials.

Type Displays the type of device as discovered by OpenManage Essentials:

• PowerVault Storage Device — The device is a Dell PowerVault MD Series 
storage array.

• PowerVault Server — The device is a Dell PowerVault NX Network Attached 
Storage (NAS) device.

• EqualLogic Storage — The device is a Dell EqualLogic storage array.
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Field Description

• PowerEdge Server Device — The device is a Dell PowerEdge, PowerEdge 
VRTX, iDRAC, or CMC device.

• PowerEdge Direct Attached Storage — The device is a PowerVault MD or NX 
Direct Attached Storage (DAS) device.

• Dell Networking — The device is a Dell Networking switch.

Service Tag Displays a unique, alphanumeric identifier that enables Dell to individually 
recognize each Dell device.

Save Click to save the changes you have made.

Cancel Click to discard the changes you have made.

Related Links

Managing devices in a device group

Manage Credentials

The Manage Credentials window enables you to provide the credentials for the device types included in 
a device group.

The left pane on the Manage Credentials window displays the device types, and the right pane enables 
you to provide the credentials. The following table provides information about the fields displayed in the 
Credentials section.

Field Description

Username Enables you to view or edit the user name of a device type.

Password Enables you to edit the password of a device type in a masked format.

Enable Password

NOTE: The 
Enable 
Password field 
is displayed 
only when the 
device type is 
Switch - Dell 
Networking.

Enables you to edit the enable password in a masked format.

Community String

NOTE: The 
Community 
String field is 
displayed only 
when the 
device type is 
Storage - 
EqualLogic.

Enables you to edit the community string in a masked format.

Save Click to save the credentials.
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Field Description

Next Click to navigates to the next device type displayed in the left pane.

Close Click to close the Manage Credentials window.

NOTE: SupportAssist does not require the credentials for collecting system logs from Dell 
PowerVault MD series storage arrays.

Related Links

Managing credentials of a device group

Manage Contacts

The Manage Contacts window enables you to provide the contact information and parts dispatch 
information for a device group.

The following table provides information about the fields displayed in the Manage Contacts window.

Field Description

Use default Select to use the contact information already available in the Settings → Contact 
Information page.

Primary Select to provide the primary contact details.

Secondary Select to provide the secondary contact details.

First Name Enables you to view or edit the first name of the primary or secondary contact.

Last Name Enables you to view or edit the last name of the primary or secondary contact.

Phone Number Enables you to view or edit the phone number of the primary or secondary 
contact.

Alternate Phone 
Number

Enables you to view or edit the alternate phone number of the primary or 
secondary contact.

Email Address Enables you to view or edit the e-mail address of the primary or secondary 
contact.

Preferred Contact 
Method

Enables you to select the preferred contact method. The available options are:

• Phone

• Email

Preferred Contact 
Hours

Enables you to view or edit the preferred hours at which Dell technical support 
can contact your primary or secondary contact in case of any issues with the 
monitored devices.

Time Zone Enables you to select the time zone of the primary or secondary contact.

Parts Dispatch (Optional)

Address

City/Town

Country

Enables you to view or edit the address to which a replacement part must be 
dispatched.
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Field Description

State/Province/
Region

Postal Code

Related Links

Viewing and updating the contact information of a device group

Edit/Delete Group

The Edit/Delete Group window enables you to edit the device group details or delete a device group.

The following table provides information about the fields displayed on the Edit/Delete Group window.

Field Description

Name Enables you to view or edit the name of the device group.

Description Enables you to view or edit the description of the device group.

Update Click to save the edited device group information.

Delete Click to delete the device group.

Cancel Click to discard the changes you have made.

Related Links

Editing device group details

Deleting a device group

Settings

The Settings tab enables you to configure SupportAssist. By default, the System Logs page is displayed 
when the Settings tab is opened. The Settings tab includes the following pages:

• System Logs

• Proxy Settings

• Preferences

• Contact Information

• System Credentials

• SMTP Settings

Related Links

System Logs

Proxy Settings

Preferences

Contact Information

System Credentials

SMTP Settings
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System Logs

The System Logs page enables you to:

• Edit the credentials required to collect the system logs from supported devices

• Schedule system log collections

The following table provides information about the fields displayed under Edit Device Credentials.

Field Description

Device Type Select the device type. The available options are:

• Server

• Storage

• Switch

Credential Type Select the specific device for which you want to provide the credentials. 
The options displayed depend on the Device Type you have selected.

The available options for Server are:

• Windows

• Linux

• ESX/ESXi

• iDRAC

• CMC

The available options for Storage are:

• EqualLogic

• MD Series

The available option for Switch is Dell Networking.

Username Enables you to view or edit the user name.

Password Enables you to provide or edit the password in a masked format.

Enable Password

NOTE: The Enable 
Password field is 
displayed only when 
the Device Type 
selected is Switch.

Enables you to edit the enable password in a masked format.

Community String Enables you to edit the community string in a masked format.
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Field Description

NOTE: The 
Community String 
field is displayed only 
when the Device 
Type selected is 
Storage and the 
Credential Type 
selected is 
EqualLogic.

Overwrite the device-
specific credentials with 
the Default Device Type 
Credentials for all devices 
belonging to the current 
Device Type and 
Credential Type 

Enables you to overwrite the device-specific credentials that you had 
previously configured for some devices, with the Default Device Type 
Credentials. Only devices (of the selected Device Type and Credential 
Type ) that you had configured with device-specific credentials are 
affected.

NOTE: If the Device Type selected is Storage and the Credential Type selected is MD Series, the 
Username and Password fields are not displayed. This is because the user name and password are 
not required for collecting the system logs from PowerVault MD series storage arrays.

The following table provides information about the fields displayed under System Log Collection 
Schedule.

NOTE: The System Log Collection Schedule options are enabled only if the Enable system log 
collection scheduling option is selected in the Preferences page.

NOTE: If the Enable system log collection scheduling option is not selected, and your devices are 
covered under the Dell ProSupport Plus service contract, you will not receive some reporting 
information about your devices.

Field Description

Frequency Enables selecting the frequency at which system logs are collected. The 
available options are:

• None

• Weekly

• Monthly

Specify day and time Enables selecting the day and time when you want to collect the system 
logs.

If the Frequency is set to Weekly, the available options are: weeks (1 or 2), 
day of the week (sunday, monday, tuesday, wednesday, thursday, friday, 
and saturday), hour (in hh:mm format), and AM/PM.

If the Frequency is set to Monthly, the available options are: week of the 
month (first, second, third, fourth, and last), day of the week (sunday, 
monday, tuesday, wednesday, thursday, friday, and saturday), hour (in 
hh:mm format), AM/PM, and months (1 or 3).

Start Date Displays the date and time at which the system logs will be collected next.
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Related Links

Settings

Configuring the default device type credentials

Scheduling the periodic collection of system logs

Overwriting the device-specific credentials with the default device type credentials

Proxy Settings

The Proxy Settings page enables you to configure the proxy server settings. The following table provides 
information about the fields displayed in the Proxy Settings page.

Field Description

Use proxy settings Select this option to enable configuring the 
proxy server settings.

Proxy Server Address or Name Enables you to view or edit the proxy server 
address or name.

Proxy Port Number Enables you to view or edit the proxy server port 
number.

Proxy requires authentication Select this option if the proxy server requires 
authentication.

Username Enables you to view or edit the proxy server user 
name.

Password Enables you to provide or edit the proxy server 
password in a masked format.

Confirm Password Enables you to retype the password provided in 
the Password field in a masked format.

Related Links

Settings

Configuring proxy server settings

Preferences

The Preferences page enables you to configure Auto Update, Email Settings, Support Collection, and 
Maintenance Mode. The following table provides information about the fields displayed in the 
Preferences page.

Field Description

Auto Update

Enable auto update Select this option to automatically download and 
install the latest SupportAssist and collection 
component updates, when they are available. The 
download and installation of the updates occur in 
the background. A message will be displayed if 
problems occur during the update process.
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Field Description

NOTE: It is recommended that you select the 
Enable auto update option, to ensure that 
SupportAssist is up-to-date with the latest 
features and enhancements.

Email Settings

Receive email notification when a new support 
case is opened

Select this option to receive an e-mail notification 
when a new support case is opened.

Preferred email Language Select the preferred language for e-mail 
notifications.

Support Collection

Automatically start a log collection when a new 
support case is generated 

Select this option to automatically start a system 
log collection when a new support case is 
generated.

Enable system log collection scheduling Select this option to enable scheduling of the 
system log collection. To schedule the system log 
collection, configure the System Log Collection 
Schedule in the System Logs tab.

Send network identification information to Dell Select this option to allow sending network 
identification information to Dell.

Maintenance Mode

Temporarily suspend case generation activity 
(e.g., for purposes of downtime, external 
troubleshooting, etc.) 

Select this option to set SupportAssist in 
maintenance mode. While in maintenance mode, 
no new support cases are opened.

Related Links

Settings

Enabling auto update

Configuring e-mail notification settings

Enabling or disabling the automatic collection of system logs

Enabling or disabling the scheduling of system log collection

Filtering the system log collection

Setting SupportAssist to maintenance mode

Contact Information

The Contact Information page enables you to view and edit the contact information and parts dispatch 
address. The following table provides information about the fields displayed in the Contact Information 
page.

Field Description

Company Name Enables you to view or edit the company name.

Primary Select this option to view the primary contact information.
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Field Description

Secondary Select this option to view the secondary contact information.

First Name Enables you to view or edit the first name of the primary or secondary 
contact.

Last Name Enables you to view or edit the last name of the primary or secondary 
contact.

Phone Number Enables you to view or edit the phone number of the primary or 
secondary contact.

Alternate Phone Number Enables you to view or edit the alternate phone number of the primary 
or secondary contact.

Email Address Enables you to view or edit the e-mail address of the primary or 
secondary contact.

Preferred Contact Method Select the preferred contact method. The available options are:

• Phone

• Email

Preferred Contact Hours Enables you to view or edit the preferred hours at which Dell technical 
support can contact your primary or secondary contact in case of any 
issues with the monitored devices.

Time Zone Select the time zone of the primary or secondary contact.

Parts Dispatch (Optional)

Address

City/Town

Country

State/Province/Region

Postal Code

Enables you to view or edit the address to which a replacement part 
must be dispatched.

Related Links

Settings

Viewing and updating the contact information

System Credentials

The System Credentials page enables you to update the credentials required to connect to OpenManage 
Essentials. SupportAssist uses the System Credentials to connect to OpenManage Essentials for retrieving 
device and alert information.

The following table provides information about the fields displayed in the System Credentials page.

Field Description

Username Enables you to view or edit user name required 
to connect to OpenManage Essentials.
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Field Description

NOTE: If the server on which SupportAssist 
is installed is a member of a domain, the 
user name must be provided in the domain
\user name format.

Password Enables you to provide or edit the password 
required to connect to OpenManage Essentials.

NOTE: The credentials you provide must of an user account that is a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.

NOTE: If you change the credentials of the user account because of the security policy 
requirements of your company or for other reasons, make sure that you also update the System 
Credentials in SupportAssist. Alternatively, it is recommended that you create a service account 
with credentials that do not expire, and provide the service account credentials.

Related Links

Settings

Configuring the system credentials

SMTP Settings

The SMTP Settings page enables you to configure SupportAssist to send e-mail notifications through the 
local SMTP server. The following table provides information about the fields displayed in the SMTP 
Settings page.

Field Description

SMTP server name/IP address Enables you to view or edit the SMTP server 
name or the IP address.

Port Number Enables you to view or provide the port number 
of the server.

SMTP server requires authentication Select to provide the credentials required to 
authenticate the SMTP server.

Username Enables you to view or edit the SMTP server user 
name.

Password Enables you to provide or edit the SMTP server 
password in a masked format.

Confirm password Enables you to retype the password provided in 
the Password field in a masked format.

Enable SSL Select to enable secure socket layer (SSL) 
communication.

Related Links

Settings

Configuring the local SMTP e-mail server settings
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Connectivity Test

The Connectivity Test page enables you to test SupportAssist connectivity to the dependent network 
resources. The following table describes the fields displayed in the Connectivity Test page.

Field Description

Check box Select the appropriate check boxes to test the connectivity status you 
want to verify.

Test Displays the dependent network resources that you can test. The 
available options are:

• Internet

• Local SMTP server

• Dell FTP server

• Dell Upload Server

• OpenManage Essentials Service

• Dell SupportAssist Server

Description Provides a description of the test.

Connectivity Status Displays an icon and a message that indicates the connectivity status. 
The possible statuses are:

 In Progress — The connectivity test is in progress.

 Connected — The connectivity test is successful.

 Error — The connectivity test is unsuccessful.

NOTE: The Error status is displayed as a link that you can click to 
view the description of the issue and the possible resolution steps.

Last verified Displays the date and time the connectivity status was last verified.

Test Connectivity Click to test connectivity to the selected resources.

Related Links

Performing the connectivity test
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Setup Wizard
The Setup Wizard guides you through the setup and registration of SupportAssist. The fields displayed in 
the pages of the Setup Wizard are described in the following sections.

Welcome

The Welcome page enables you to start the SupportAssist setup. Click Next to start setting up 
SupportAssist.

Proxy Settings

The Proxy Settings page enables you to configure the proxy server settings.

NOTE: The Proxy Settings page is only displayed if the server on which SupportAssist is installed 
connects to the internet through a proxy server.

The following table provides information about the fields displayed in the Proxy Settings page.

Field Description

Use proxy settings Select this option to enable configuring the proxy 
server settings.

Proxy Server Address or Name The proxy server address or name.

Proxy Port Number The proxy server port number.

Proxy requires authentication Select this option if the proxy server requires 
authentication.

Username The user name required to connect to the proxy 
server.

Password The password required to connect to the proxy 
server.

Back Click to navigate to the Welcome page.

Next Click to verify connectivity to the proxy server 
using the provided proxy details.

Registration

The Registration page enables you to provide your primary contact information and register 
SupportAssist.

The following table provides information about the fields displayed in the Registration page.

Field Description

Company Information

Company Name The name of the company.

Country/Territory The location of the company.
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Field Description

Primary Contact Information

First Name The first name of the primary contact.

Last Name The last name of the primary contact.

Phone Number The phone number of the primary contact.

Alternate Phone Number The alternate phone number of the primary 
contact.

Email Address The e-mail address to which SupportAssist e-
mail notifications must be sent.

Preferences

Preferred Email Language The language in which you prefer to receive 
SupportAssist e-mail notifications.

Back Click to navigate to the Proxy Settings page or 
Welcome page.

Next Click to register SupportAssist with the provided 
contact information.

System Credentials

The System Credentials page enables you to provide the credentials required to connect to 
OpenManage Essentials. SupportAssist uses the System Credentials to connect to OpenManage 
Essentials for retrieving device and alert information.

The following table provides information about the fields displayed in the System Credentials page.

Field Description

Username The user name required to connect to 
OpenManage Essentials.

NOTE: If the server on which SupportAssist 
is installed is a member of a domain, the 
user name must be provided in the domain
\user name format.

Password The password required to connect to 
OpenManage Essentials.

Back Click to navigate to the Registration page.

Next Click to verify connectivity to OpenManage 
Essentials using the provided credentials.

NOTE: The credentials you provide must of an user account that is a member of the OpenManage 
Essentials Administrators, Power Users, or Site Administrators group.
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NOTE: If you change the credentials of the user account because of the security policy 
requirements of your company or for other reasons, make sure that you also update the System 
Credentials in SupportAssist. Alternatively, it is recommended that you create a service account 
with credentials that do not expire, and provide the service account credentials.

Summary

The Summary page enables you to start SupportAssist. Click Finish to close the SupportAssist Setup 
Wizard and open the SupportAssist Case List page.
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6
Related documents and resources

Other documents you may need

In addition to this guide, you can access the following guides available at the Dell Support website:

• Dell OpenManage Essentials Version 2.0 User’s Guide

• Dell SupportAssist Version 2.0 for Dell OpenManage Essentials Support Matrix

• Dell SupportAssist Version 2.0 for Dell OpenManage Essentials Quick Start Guide

• Dell SupportAssist Version 2.0 for Dell OpenManage Essentials Release Notes

• Dell System E-Support Tool User’s Guide

• Dell Lasso User's Guide

• Monitoring Dell EqualLogic Storage Arrays Using Dell SupportAssist

• Monitoring Dell Networking Switches Using Dell SupportAssist

• Monitoring Dell PowerVault MD Series Storage Arrays Using Dell SupportAssist

• Monitoring iDRAC Using Dell SupportAssist

• Managing Windows Device Credentials in SupportAssist Using Service Account

SupportAssist Community

You can also find video tutorials, peer-to-peer questions, user’s guides, and other useful information at 
the community for SupportAssist users at Dell.com/SupportAssistGroup.

Dell Remote Consulting Service

You can use your existing Dell Remote Consulting Service contract or place an order and schedule time 
with a systems management deployment expert for OpenManage Essentials and SupportAssist 
installation, set up, and configuration from start to finish. For more information, click the Remote 
Consulting Services link at Dell.com/learn/enterprise-deployment-and-configuration.
Related Links

Accessing documents from Dell support site

Contacting Dell

Accessing documents from Dell support site

You can access the required documents in one of the following ways:

• Using the following links:

– For all Systems Management documents — dell.com/softwaresecuritymanuals

– For Remote Enterprise Systems Management documents — dell.com/esmmanuals
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– For Enterprise Systems Management documents — dell.com/openmanagemanuals

– For Client Systems Management documents — dell.com/clientsystemsmanagement

– For Serviceability Tools documents — dell.com/serviceabilitytools

– For OpenManage Connections Enterprise Systems Management documents — dell.com/
OMConnectionsEnterpriseSystemsManagement

– For OpenManage Connections Client Systems Management documents — dell.com/
connectionsclientsystemsmanagement

• From the Dell Support site:

a. Go to dell.com/support/manuals.

b. Under General support section, click Software & Security. 

c. In the Software & Security group box, click the required link from the following:

– Serviceability Tools

– Enterprise Systems Management

– Client Systems Management

– Remote Enterprise Systems Management

– Connections Client Systems Management 

d. To view a document, click the required product version.

• Using search engines:

– Type the name and version of the document in the search box.

Related Links

Related documents and resources

Contacting Dell
NOTE: If you do not have an active Internet connection, you can find contact information on your 
purchase invoice, packing slip, bill, or Dell product catalog.

Dell provides several online and telephone-based support and service options. Availability varies by 
country and product, and some services may not be available in your area. To contact Dell for sales, 
technical support, or customer service issues:

1. Go to dell.com/support.

2. Select your support category.

3. Verify your country or region in the Choose a Country/Region drop-down list at the top of page.

4. Select the appropriate service or support link based on your need.

Related Links

Related documents and resources
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7
Error code appendix
The following table lists the error codes, error messages, and possible resolutions.

Error code Error message Possible resolution

1000_1 SupportAssist is unable to run a collection 
component on <device name> because the 
component is not supported on the 
operating system running on the device.

For information on the supported devices 
and operating systems, see the Dell 
SupportAssist for Dell OpenManage 
Essentials Support Matrix at Dell.com/
ServiceabilityTools.

1000_2 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_3 SupportAssist is unable to run a collection 
component on <device name> because the 
connection interface is not supported.

Ensure that:

• The device is reachable.

• Ports 22, 23, 80, 135, 443, 1311, 2463, 
and 5989 are open on the device.

1000_4 SupportAssist cannot run a collection 
component on <device name> because the 
device does not have an Enterprise license.

Perform the following:

1. Upgrade to Enterprise license.

2. Navigate to the Devices tab, select the 
device, and then click Send System 
Logs.

1000_5 SupportAssist is unable to run a collection 
component on <device name>.

Perform the following:

1. Ensure that the Administrator 
credentials you have provided for the 
device in SupportAssist is correct.

2. Navigate to the Devices tab, select the 
device, and then click Send System 
Logs.

1000_6 SupportAssist is unable to run a collection 
component on <device name>.

Ensure the following:

• Provide the Administrator credentials for 
the device in SupportAssist.

• Dell OpenManage Server Administrator 
(OMSA) is installed and the OMSA 
services are running on the device.

• iDRAC firmware is updated, if applicable.
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Error code Error message Possible resolution

1000_7 SupportAssist is unable to run a collection 
component on <device name>.

Perform the following:

1. Ensure that the Administrator 
credentials you have provided for the 
device in SupportAssist is correct.

2. Navigate to the Devices tab, select the 
device, and then click Send System 
Logs.

1000_8 SupportAssist is unable to run a collection 
component on <device name>.

Ensure the following:

• Dell OpenManage Server Administrator 
(OMSA) is installed and the OMSA 
services are running on the device.

• iDRAC firmware is updated, if applicable.

1000_9 SupportAssist is unable to run a collection 
component on <device name>.

Ensure the following:

• Dell OpenManage Server Administrator 
(OMSA) is installed and the OMSA 
services are running on the device.

• iDRAC firmware is updated, if applicable.

1000_10 SupportAssist is unable to run a collection 
component on <device name> .

If the device is running a Windows operating 
system, ensure that WMI service is running 
on the device.

1000_11 SupportAssist is unable to run a collection 
component on <device name> .

If the device is running a Windows operating 
system, ensure that WMI service is running 
on the device.

1000_12 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_13 SupportAssist is unable to run a collection 
component on <device name> because 
sufficient free space may not be available on 
the system.

Ensure that the C:\ drive has free space 
available.

1000_14 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_18 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_19 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
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Error code Error message Possible resolution

Contact Dell technical support for 
assistance.

1000_20 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_21 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_22 SupportAssist is unable to upload the 
collection file from <device name> because 
the collection file size exceeds the 
predefined upload file size limit.

If the problem persists, contact Dell 
technical support for assistance.

1000_23 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_24 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_25 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_26 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_27 SupportAssist is unable to upload the 
collection file from <device name> because 
the upload process exceeded the 
predefined time limit.

Run the collection component after some 
time — Navigate to the Devices tab, select 
the device, and then click Send System 
Logs.

1000_28 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_29 SupportAssist is unable to upload the 
collection file from <device name>.

Ensure that the proxy server is reachable.

1000_30 SupportAssist is unable to upload the 
collection file from <device name> because 

n/a
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Error code Error message Possible resolution

the proxy authentication method is not 
supported. Only Basic and NTLM 
authentication methods are supported.

1000_31 SupportAssist is unable to upload the 
collection file from <device name>.

Perform the following:

1. Ensure that the proxy server credentials 
you have provided in SupportAssist is 
correct. 

2. Navigate to the Devices tab, select the 
device, and then click Send System 
Logs.

1000_40 SupportAssist is unable to upload the 
collection file from <device name>.

Perform the following:

1. Ensure that the Administrator 
credentials you have provided for the 
device in SupportAssist is correct. 

2. Navigate to the Devices tab, select the 
device, and then click Send System 
Logs.

1000_41 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

1000_42 SupportAssist is unable to run a collection 
component on <device name> .

If the device is running a Windows operating 
system, ensure that WMI service is running 
on the device.

2000_6 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_7 SupportAssist is unable to upload the 
collection file from <device name> because 
of an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_20 SupportAssist is unable to upload the 
collection file from <device name> because 
of an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_21 SupportAssist is unable to upload the 
collection file from <device name> because 
of an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_22 SupportAssist is unable to upload the 
collection file from <device name> because 

If the problem persists, contact Dell 
technical support for assistance.
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Error code Error message Possible resolution

the collection file size exceeds the 
predefined upload file size limit.

2000_23 SupportAssist is unable to upload the 
collection file from <device name> because 
of an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_24 SupportAssist is unable to upload the 
collection file from <device name> because 
of an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_25 SupportAssist is unable to upload the 
collection file from <device name> because 
of an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_26 SupportAssist is unable to upload the 
collection file from <device name> because 
of an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_27 SupportAssist is unable to upload the 
collection file from <device name> because 
the upload process exceeded the 
predefined time limit.

Run the collection component after some 
time — Navigate to the Devices tab, select 
the device, and then click Send System 
Logs.

2000_28 SupportAssist is unable to upload the 
collection file from <device name> because 
of an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_29 SupportAssist is unable to upload the 
collection file from <device name>.

Ensure that the proxy server is reachable.

2000_30 SupportAssist is unable to upload the 
collection file from <device name> because 
the proxy authentication method is not 
supported. Only Basic and NTLM 
authentication methods are supported.

n/a

2000_31 SupportAssist is unable to upload the 
collection file from <device name>.

Perform the following:

1. Ensure that the proxy server credentials 
you have provided in SupportAssist is 
correct. 

2. Navigate to the Devices tab, select the 
device, and then click Send System 
Logs.
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Error code Error message Possible resolution

2000_32 SupportAssist is unable to upload the 
collection file from <device name> because 
of an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_109 SupportAssist is unable to run a collection 
component on <device name> because 
another instance of the collection 
component is already running on the 
device.

Run the collection component after some 
time — Navigate to the Devices tab, select 
the device, and then click Send System 
Logs.

2000_187 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that the FTP service is running on 
the device host.

2000_188 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that the Dell PowerVault MD Storage 
Manager software is installed on the device 
host.

2000_189 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that a supported version of Dell 
PowerVault MD Storage Manager software 
is installed on the device host.

2000_191 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_192 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that the device is reachable.

2000_193 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that SSH is enabled on the device.

2000_195 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that SNMP is enabled on the device.

2000_196 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_197 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that Dell EqualLogic firmware 
version 4.3.0 or later is installed on the 
device.

2000_198 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that SSH and Telnet are enabled on 
the device.

2000_199 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that the Administrator credentials 
you have provided for the device in 
SupportAssist is correct.
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Error code Error message Possible resolution

2000_298 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_299 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_401 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_403 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_404 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_405 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_417 SupportAssist is unable to run a collection 
component on <device name> because the 
collection processes exceeded the 
predefined time limit.

On the management server running 
OpenManage Essentials:

1. Navigate to C:\Program Files (x86)\Dell
\Lasso.

2. Open the ESC.properties file using any 
text editor.

3. Increase the timeout value of 
appropriate networking switch that 
displayed the error. For example, if the 
error occurred in a Dell Networking 
(previously Dell PowerConnect) switch, 
increase the value of the 
powerconnectethernet.timeout 
property.

4. Save the ESC.properties file.

The following are the timeout properties 
that you may have to edit based on the 
networking switch that displays an error:

• powerconnectethernet.timeout

• force10.timeout
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Error code Error message Possible resolution

• powerconnectM8428-k.timeout

2000_418 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_420 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_422 SupportAssist is unable to run a collection 
component on <device name> because the 
required file could not be downloaded 
within the predefined time limit.

On the management server running 
OpenManage Essentials:

1. Navigate to C:\Program Files (x86)\Dell
\Lasso.

2. Open the NAS.properties file using any 
text editor.

3. Increase the value of the 
nas.ftp.connection.timeout property.

4. Save the NAS.properties file.

2000_499 SupportAssist is unable to run a collection 
component on <device name>.

Perform the following:

1. Ensure that the Administrator 
credentials you have provided for the 
device in SupportAssist is correct. 

2. Navigate to the Devices tab, select the 
device, and then click Send System 
Logs.

2000_802 SupportAssist is unable to run a collection 
component on <device name> because 
another instance of the collection 
component is already running on the 
device.

Run the collection component after some 
time — Navigate to the Devices tab, select 
the device, and then click Send System 
Logs.

2000_803 SupportAssist is unable to run a collection 
component on<device name> because the 
collection processes exceeded the 
predefined time limit.

On the management server running 
OpenManage Essentials:

1. Navigate to C:\Program Files (x86)\Dell
\Lasso.

2. Open the Enclosure.properties file 
using any text editor.

3. Increase the value of the 
enclosure.timeout.value property.

4. Save the Enclosure.properties file.

2000_805 SupportAssist is unable to run a collection 
component on <device name>.

Perform the following:
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Error code Error message Possible resolution

1. Ensure that the Administrator 
credentials you have provided for the 
device in SupportAssist is correct. 

2. Navigate to the Devices tab, select the 
device, and then click Send System 
Logs.

2000_901 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

2000_904 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that:

• The device is reachable.

• SNMP is enabled on the device.

2000_909 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_20 SupportAssist is unable to upload the 
collection file <device name> because of an 
internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_21 SupportAssist is unable to upload the 
collection file <device name> because of an 
internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_22 SupportAssist is unable to upload the 
collection file <device name> because the 
collection file size exceeds the predefined 
upload file size limit

If the problem persists, contact Dell 
technical support for assistance.

SA_23 SupportAssist is unable to upload the 
collection file <device name> because of an 
internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_24 SupportAssist is unable to upload the 
collection file <device name> because of an 
internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_25 SupportAssist is unable to upload the 
collection file <device name> because of an 
internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.
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SA_26 SupportAssist is unable to upload the 
collection file <device name> because of an 
internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_27 SupportAssist is unable to upload the 
collection file <device name> because of an 
internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_28 SupportAssist is unable to upload the 
collection file <device name> because of an 
internal error.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_29 SupportAssist is unable to upload the 
collection file <device name>.

Perform the following:

1. Ensure that the proxy server credentials 
you have provided in SupportAssist is 
correct. 

2. Navigate to the Devices tab, select the 
device, and then click Send System 
Logs.

SA_30 SupportAssist is unable to upload the 
collection file <device name> because the 
proxy authentication method is not 
supported. Only Basic and NTLM 
authentication methods are supported.

n/a

SA_31  SupportAssist is unable to upload the 
collection file <device name>.

Perform the following:

1. Ensure that the proxy server credentials 
you have provided in SupportAssist is 
correct. 

2. Navigate to the Devices tab, select the 
device, and then click Send System 
Logs.

SA_101 SupportAssist is unable to run a collection 
component on <device name> because of 
an internal error

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_102 Case access error. If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_103 Case service unavailable. If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.
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Error code Error message Possible resolution

SA_104 Collection component is not supported. n/a

SA_105 SupportAssist component installation is 
unsuccessful.

If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_106 SupportAssist component is not available. If the problem persists, the log files may be 
required for further troubleshooting. 
Contact Dell technical support for 
assistance.

SA_108 SupportAssist is unable to run a collection 
component on <device name>.

Ensure that the Administrator credentials 
you have provided for the device in 
SupportAssist is correct.
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